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Preface
Installing Rational Suite provides procedures to install Rational Suite, including an
overview of how to configure the point-products within Rational Suite. Detailed
procedures about point product configurations, as well as standalone installations, are
available in the individual point product documentation.

Rational Suite delivers a comprehensive set of integrated tools that embody software
engineering best practices and span the entire software development lifecycle.
Rational Suite's unparalleled level of integration improves communication both
within teams and across team boundaries, reducing development time, and
improving software quality.

Audience

This guide is intended for system administrators, project managers, and all members
of the software development team, including requirements developers, software
architects and developers, and quality engineers. It assumes a knowledge of Microsoft
Windows and its conventions.

Other Resources

� All manuals are available online, either in HTML or PDF format. The online
manuals are on the Rational Solutions for Windows Online Documentation
CD-ROM.

� To send feedback about documentation for Rational products, please send e-mail
to techpubs@rational.com.

� For more information about Rational Software technical publications, see:
http://www.rational.com/documentation.

� For more information on training opportunities, see the Rational University Web
site: http://www.rational.com/university.

� For articles, discussion forums, and Web-based training courses on developing
software with Rational Suite products, join the Rational Developer Network by
selecting Start > Rational Suite > Logon to the Rational Developer Network.
xiii
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Contacting Rational Technical Support

If you have questions about installing, using, or maintaining this product, contact
Rational Technical Support as follows:

Note: When you contact Rational Technical Support, be prepared to supply the
following information:

� Your name, company name, telephone number, and e-mail address

� Your operating system, version number, and any service packs or patches you
have applied

� Product name and release number

� Your case ID number (if you are following up on a previously reported problem)

Your Location Telephone Facsimile E-mail

North America (800) 433-5444
(toll free)

(408) 863-4000
Cupertino, CA

(781) 676-2460
Lexington, MA

support@rational.com

Europe, Middle
East, Africa

+31 (0) 20-4546-200
Netherlands

+31 (0) 20-4545-201
Netherlands

support@europe.rational.com

Asia Pacific +61-2-9419-0111
Australia

+61-2-9419-0123
Australia

support@apac.rational.com
Contacting Rational Technical Support xv
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1Using This Guide
The Rational Software Setup program lets you perform typical, compact, custom, and
network installations of Rational Suite. This common procedure installs Rational Suite
as well as standalone versions of point products. The term Rational product used
throughout this manual refers to standalone point products and Rational Suite.

This manual provides an overview of requirements for installing Rational Suite as
well as requirements for configuring point products within Rational Suite. To perform
a standalone installation of a point product, read the product’s installation manual on
the Rational Solutions for Windows Documentation CD-ROM. The system and
software requirements may vary when you install a point product outside of Rational
Suite.

To install Rational Suite ContentStudio, read the Installing Rational Suite ContentStudio
manual. Installing Rational Suite does not cover ContentStudio installation
requirements.

This manual provides you with:

� Information needed to perform a typical or custom installation of Rational Suite.

� An overview of the pre- and post-configuration requirements for setting up
Rational Suite databases.

� An overview of the pre- and post-configuration requirements for Rational Suite
Web applications.

� Information about upgrading from earlier releases of Rational Suite.

� Instructions for configuring a silent installation of Rational Suite

� Instructions for configuring a network installation of Rational Suite.

� Instructions for removing Rational Suite.

� Support information, including references to additional sources of information
and help, in the Preface on page xiii.

To help you navigate through this manual, see Installation Roadmap on page 18.
17



Installation Roadmap

The Installation Roadmap and Table 1 on page 19 help you navigate through this
guide. Read Troubleshooting on page 131 or the Preface on page xiii if you see error
messages or encounter problems during installation.

Installation Roadmap
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Table 1 Installing Rational Suite

To See

Deploy a first-time installation
of Rational Suite

� The Administering Licenses for Rational Software
manual to install and configure licenses either before
or after installing the product.

� The Rational Software Setup and product-specific
requirements for an initial installation in the chapter
Before You Install – First Time Installation on page 23.

� The chapter Installing Rational Suite on page 59 for the
installation procedure.

� The product-specific configuration requirements in
the chapter After You Install – First Time Installation on
page 65.

Deploy Rational Suite using a
silent installation

� The Administering Licenses for Rational Software
manual to install and configure licenses either before
or after installing the product.

� The chapter Silent and Network Installations on
page 121 for the silent installation procedure.

� The Rational Software Setup and product-specific
requirements for an initial installation in the chapter
Before You Install – First Time Installation on page 23.

� The chapter Installing Rational Suite on page 59 for the
installation procedure.

Deploy Rational Suite using a
network installation

� The Administering Licenses for Rational Software
manual to install and configure licenses either before
or after installing the product.

� The chapter Silent and Network Installations on
page 121 for the minimal installation procedure.

� Rational Suite and product-specific requirements for
an initial installation in the chapter Before You Install –
First Time Installation on page 23.

� The chapter Installing Rational Suite on page 59 for the
installation procedure.
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Products in Each Rational Suite

Rational Suite is an integrated set of software development tools, combined with the
Rational Unified Process. Rational Suite is available in several editions, each tailored
to the needs of a specific organization or user.

Deploy Rational Suite Web
applications.

� The Administering Licenses for Rational Software
manual to install and configure licenses either before
or after installing the product.

� Rational Suite and product-specific requirements for
an initial installation in the chapter Before You Install –
Web Component Installation on page 53.

� The chapter Installing Rational Suite on page 59 for the
installation procedure.

� The product-specific configuration requirements in
the chapter After You Install – Web Component
Installation on page 71.

Upgrade to a new release of
Rational Suite

� The chapter Upgrading from Earlier Versions of Rational
Suite on page 73 for upgrade requirements.

� The chapter Removing Rational Suite on page 117 if
you need to remove an earlier version of the product.

Install additional Rational
software and third-party
components

� The product-specific installation and configuration
requirements in the chapter After You Install – First
Time Installation on page 65.

� The chapter Installing Rational Suite on page 59 for the
installation procedure.

Remove Rational Suite from
your system

� The Administering Licenses for Rational Software
manual to move license keys to another system or
return license keys to Rational Software.

� The chapter Removing Rational Suite on page 117 for
the removal procedure.

Table 1 Installing Rational Suite (continued)

To See
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Rational Suite: Summary

This table shows which tools are included with each edition of Rational Suite.
The Project

Leader
The Analyst The Developer The Tester All Roles

Team Unifying
Platform

AnalystStudio DevelopmentStudio DevelopmentStudio
RealTime Edition

TestStudio Enterprise

Windows Windows Windows UNIX Windows Windows Windows

Rational Tool

Te
am

U
n

if
yi

n
g

P
la

tf
or

m

Rational Unified
Process

• • • • • • •

Rational
RequisitePro

• • • • W • • •

Rational
ClearQuest

• • • • W • • •

Rational SoDA
for Word

• • • • F • • •

Rational
ClearCase LT

• • • • • •

Rational
TestManager

• • • • • •

Rational Rose • M • E • E • RT • E

Rational Robot • • 
Rational
TestFactory

• •

Rational
PureCoverage

• • • • •

Rational Purify • • • • •
Rational
Quantify

• • • • •

Rational Process
Workbench

•

M = Data Modeler Edition
E = Enterprise Edition
RT = RealTime Edition
F = Rational SoDA for FrameMaker
W = Accessed through the tool’s Web interface
NOTE: For information on Rational Suite ContentStudio, see http://www.rational.com/products/cstudio.
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2Before You Install – First
Time Installation
This chapter provides an overview of tasks for installing Rational Suite for the first
time. The following topics cover licensing, administrator privileges, and options and
requirements in the Rational Software Setup program. The Rational Suite product
sections include an overview of additional requirements for initial Suite installations.

Rational Software Setup – Before You Install

The following sections cover general requirements for running the Rational Software
Setup program, planning your installation, and using Rational Software.

Administering Licenses for Rational Software

You can request and install license keys before or after installing Rational products;
however, you must have a license key installed and configured to run a Rational
product. In the Rational Software Setup program, a green check mark next to a
Rational product indicates you have a license key configured for that product. If you
do not see a green check mark next to the product you want to install, you may want
to install a license key before you install the product. To configure a license key, click
the Configure Licenses button to launch the Rational License Key Administrator
(LKAD) and the License Key Administrator Wizard. Both tools provide online Help. If
you do not install the license keys before you install the product, the LKAD will
appear at the end of the installation.

The Administering Licenses for Rational Software manual describes the web-based
license manager Rational AccountLink, Rational licensing terms, and the Rational
License Key Administrator. The Setup program installs the LKAD automatically with
each point product within Rational Suite. Administering Licenses for Rational Software
also provides instructions for acquiring, installing, upgrading, and configuring
floating and node-locked license keys.
23



If you install Rational Suite and other Rational Software products on the same system,
there is an order in which the products will use licenses on the client or the license
server. To learn more about license usage order, see the Administering Licenses for
Rational Software manual.

Note: If you plan to upgrade the Rational license server, and this server has other
Rational products installed on its system, you must either remove the Rational
products from the system or upgrade the Rational products to the current release.
Older Rational products may not work with an upgraded license server if they are on
the same system.

Licensing Windows NT Components for DevelopmentStudio on
UNIX

To run the Windows NT components for DevelopmentStudio on UNIX, request a
floating license from AccountLink (www.rational.com/accountlink). When you receive the
permanent license key file from AccountLink, import the file on the Rational license
server.

� A UNIX license server can serve floating licenses to Windows (NT components)
and UNIX (UNIX Suite) clients. To set up a Rational license server on a UNIX
system, see the Installing DevelopmentStudio for UNIX manual.

� A Windows license server can serve floating licenses to Windows (NT
components) and UNIX (UNIX Suite) clients. To set up a Rational license server on
a Windows system, see Administering Licenses for Rational Software or use the
Rational License Key Administrator Help.

Administrator Privileges

To use the Rational Software Setup program on a Windows NT or 2000 system, you
must have Windows NT or 2000 administrator privileges on the local system. Log in
as one of the following users:

� Local administrator
� Member of the local administrator’s group
� Domain administrator who is a member of the local administrator’s group
24 Chapter 2 - Before You Install – First Time Installation



Selecting an Installation Type

The Rational Software Setup program provides you with several installation types,
allowing you to install the configuration most appropriate for your system. Table 2
describes each type.

Table 3 lists Rational Suite features that you can install using the Custom
Installation Type.

Table 2 Installation Types

Type Description

Typical � Installs the most commonly used features for a product.
� Use this option for standard installations.

Custom � Allows you to add or remove product features for installation.
� Defaults to all features in a Typical installation.
� Use this option to install Web server components and other Rational

Suite feature components. See Table 3 on page 26 for a feature list.

Compact � Installs a subset of the standard configuration. May omit optional
files, including online documentation or online Help. To find out
which files will be installed, read the product’s release notes.

� Use this option for installations on systems with limited disk space.

Network � Installs the required files on your system to run the program from a
network location.

� Use this option to run a program from a centrally managed location.
� We recommend that you map a drive on your local system to the

source directory on the network before you select this option. Select
the Reconnect at Logon option in the Windows Map Network
Drive dialog box.

� This installation type is available to you when a system
administrator has copied and decompressed the product files to a
target directory. (If you are a system administrator, see Performing
Network Installations on page 125 to set up a source directory for
network installations.)

Note: If you have older Rational products on your system, you cannot
perform upgrades with network installations.
Rational Software Setup – Before You Install 25



For more information about feature configuration requirements, see the product-
specific section in this chapter or Before You Install – Web Component Installation on
page 53.

Installing Shared Files

The Rational Software Setup program installs some shared components, which is
software provided by a company other than Rational. The Rational Suite Release Notes
includes a complete list of third party components that are installed with Rational
Suite.

These components are potentially available to other applications on your system.
Setup installs the U.S. English version of these files. It does not overwrite newer file
versions.

If the Setup program needs to update shared components, it displays a list of the
shared components that require updates. The files listed must be installed on your
system before the installation can proceed.

Table 3 Rational Suite Features

Rational Suite Point
Product

Feature
Where You Need to Install
Feature

ClearQuest ClearQuest Administrator ClearQuest administrator’s
system

ClearQuest ClearQuest Client ClearQuest client

ClearQuest ClearQuest Web Web server

RequisitePro database configuration
scripts

Database server

RequisitePro RequisiteWeb RequisiteWeb Requirements
server

TestManager ManualTest Web Execution Web server

Rational Unified
Process

IBM e-Business content Client

Rational Unified
Process

Microsoft Web Solutions
platform

Client
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Installing Files Yourself

In general, we recommend that you allow the installation procedure to install shared
files for you. In the following circumstances, you may want to install the files yourself:

� You are using a U.S. English system, but installing new files may invalidate your
current environment. In this case, you need to determine how to correct your
environment so that you can run existing tools and the Rational products you
want to install.

� Your site may mandate that you obtain shared files directly from the source, for
example, from Microsoft, rather than using files supplied by a third party. Or your
site may prohibit end users from installing shared components.

� You may want to install equivalent files that are localized to your language.

The check box, Replace files with newer versions in English, is enabled when
you have installed earlier versions of shared files that are localized to a non-U.S.
English language.

❑ If you select this check box, the U.S. English versions of the files will replace
your localized versions.

❑ If you clear this check box, you can save and print the list of files that need to be
updated. You will need to update the files yourself.

� There may be a later version of the files available. Rational products should work
with the supplied version of shared files or any later versions.

Ensuring Version Compatibility

When you have older Rational products installed on your system, you have to ensure
that all Rational products on that system are upgraded to the same version. Because
Rational tools share files and components, a new installation can cause the older
Rational products to stop working. If there are Rational beta releases on the system,
remove the beta releases before you install a later version. See Removing Rational Suite
on page 117 to remove the older Rational products from your system.

If the Rational Software Setup detects older products on your system, you will see the
Upgrade Compatibility dialog box. For each of the Rational products listed in the
Upgrade Compatibility dialog box, we strongly recommend that you do one of the
following:

❑ Upgrade it: Complete the installation. To upgrade older Rational products on
clients, see Removing Earlier Versions of Rational Suite on page 75 for a list of
Rational products that you must remove from your system before you can
restart the Setup program and install current versions of these products. To
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upgrade older products on server or administrator systems, see the chapter
Upgrading from Earlier Versions of Rational Suite on page 73. Upgrading each
product updates all necessary files, registry entries, startup menu items, and
shared components on your system.

Note: You cannot perform upgrades with network installations. For more
information about network installations, see Selecting an Installation Type on
page 25.

❑ Remove it: Complete this installation. Then see Removing Rational Suite on
page 117 to remove the older Rational products from your system.

Rational Software Setup Installation Requirements

The following general requirements are necessary to run the Rational Software Setup
program and to install Rational Software products for the first time at your site.

1 Order your permanent Rational license keys from Rational AccountLink
(www.rational.com/accountlink). You can install the Rational license keys before or
after you install Rational software. Read each Rational Suite product’s Before You
Install section for any special licensing requirements.

See the Administering Licenses for Rational Software manual for information about
installing node-locked license keys on a client system or installing floating license
keys on a license server.

Note: You need to install Rational licenses to use Rational products.

2 You can install the Rational license server software and SQL Server Anywhere
from either Rational Solutions for Windows Disc 1 or Disc 2. Rational Solutions
Disc 2 includes Rational Rose RealTime and Rational Suite RealTime Edition. Disc
1 provides all other Rational products.

3 The Rational Software Setup program requires that you install all Rational
products in the same directory. If you already have Rational products installed on
your system, the Setup program installs additional Rational products in the same
directory.

4 Make sure you have administrator privileges before installing Rational products.
Read the section Administrator Privileges on page 24 if you have not read it already.

5 Make sure that you have a current backup of your Registry and system directories.

6 Ensure that other programs are not running before you start the installation.

7 Turn off all virus protection software. These programs often run in the background
and interfere with the installation and file decompression process.
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8 Turn off any user interface managers or desktop environments that run on top of
Microsoft Windows.

9 Change to a standard VGA video driver while Rational Setup is running, or
disable video features such as virtual screens or screen switching.

10 Change to a standard mouse driver, or disable special mouse features that perform
tasks such as leaving pointer trails or changing pointer sizes.

11 Make certain that your system meets the minimum requirements.

12 The Rational Software Setup program uses C:\Program Files\Rational as the default
install path. The program installs software system files in the Windows directory
or Windows systems directory.

If your C:\ drive lacks sufficient free disk space, you may either specify another
drive during the installation procedure or make space available on the default
drive. The Software Setup program will report the amount of space required on all
drives for your installation.

Note: The Setup program installs Microsoft Core Components and some
additional files on the same drive as the operating system (often the C:\ drive),
even if you have specified an alternate drive for installation. These files can require
up to 20 MB of disk space on your hard drive.

Rational Suite – Before You Install

The following sections provide tasks you should perform and information you must
prepare before you install Rational Suite. To install Rational Suite, you must also
perform configuration tasks for the point products within Rational Suite. See the point
product sections in this chapter for an overview of those requirements.
Rational Suite – Before You Install 29



Rational Suite DevelopmentStudio on UNIX (Windows NT Components)

Refer to the Rational RequisitePro, ClearQuest, and testing products sections in this
chapter and in After You Install – First Time Installation on page 65 for an overview of
pre-installation and post-installation tasks. For information about licensing the
Windows NT components, see Licensing Windows NT Components for
DevelopmentStudio on UNIX on page 24.

Planning Your Rational Suite Environment

To help you plan your Rational Suite environment, you need to determine which
systems will be server systems. Servers need to be highly available, and may need
extra memory and disk space. Table 4 describes the types of servers you may need.

Table 4 Servers Used with Rational Suite

Type of Server Description

License server If you use floating licenses, you need to set up a server to administer
the licenses. For more information, see the Administering Licenses for
Rational Software manual or the Rational License Key Administrator
Help.

Web server � Some Rational tools include a Web component. You can set up a
Web server for these tools: ClearCase LT, ClearQuest,
RequisitePro, Rational Test Manager.

� You can install the ClearQuest Web server and the RequisiteWeb
Requirements server on the same system.

� See the chapter Before You Install – Web Component Installation on
page 53 for an overview of instructions.

Database server � If you are using commercial databases with Rational Suite
products, you probably want to install those databases on
dedicated systems.

� The following Rational tools require databases: ClearQuest,
RequisitePro, and Rose Data Modeler. See the point product
sections in this chapter for an overview of configuration tasks.

� ClearQuest requires at least two databases each.
� We recommend, for improved performance, security, and

reliability, the ClearQuest database server and the ClearQuest Web
server be two different systems, each with its software installed
onto a Windows NT File System (NTFS) partition.

� Microsoft Access Runtime is automatically installed when you
install at least one Rational Suite product on your system. Sybase
SQL Anywhere is available on the Rational Solutions for Windows
Disc 1 or 2, but it is configured to work only with Rational
products.
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ClearCase LT server ClearCase LT is a client/server product. To use a ClearCase LT client,
a ClearCase LT server must be installed in the same network domain
as the clients. A client can work with exactly one server. For
guidelines about selecting a ClearCase LT server system, see the
manual Installing Rational ClearCase LT.

ClearQuest
administrator’s system

To use ClearQuest, you need to designate one system as the
administrator’s system. See Rational ClearQuest – Before You Install on
page 41 for an overview.

Table 4 Servers Used with Rational Suite (continued)

Type of Server Description
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Rational Suite System and Software Requirements

Table 5 describes the system and software requirements for installing Rational Suite.
For standalone installation requirements, see the point product release notes.

h

Table 5 Rational Suite Requirements

Item Minimum Requirements

Operating Systems � Windows NT 4.0 Service Pack 6a
� Windows 2000 Professional Service Pack 1
� Windows 98 Second Edition
� Windows Millenium Edition

Note: Rational Suite DevelopmentStudio – RealTime Edition,
ClearCase LT server, Purify, Quantify, and PureCoverage do not
support Windows 98 and Windows Millenium Edition.

Windows XP is not supported at this time.

Hardware
Requirements

� 500 MHz or higher is recommended
� 256 MB RAM or higher is recommended;

more memory generally improves responsiveness
� 2 GB free disk space on a single drive
� Network installation: 2.6 GB space on network, 584 MB space on

systems

Note:
� ClearCase LT server – 128 MB RAM required minimum
� Rational Rose – memory requirements increase with the size of the

model
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Disk Space:
� Enterprise Suite

(no tutorial)
� AnalystStudio
� DevelopmentStudio
� DevelopmentStudio

– RealTime
Edition

� TestStudio
� DevelopmentStudio

on UNIX
� Developer Kit
� Web Components
� ClearCase LT

server

1.3 GB or higher

650 MB or higher

775 MB or higher

775 MB or higher

675 MB or higher

1.0 GB or higher

175 MB or higher

350 MB or higher

70 MB or higher
The ClearCase LT server also needs enough disk space to contain the
files and databases under source control. The amount of space
required depends on the characteristics and use of the VOBs and
views.

Windows Terminal
Server

� Windows NT 4.0 Service Pack 4 or higher
� Windows 2000 Server

Hosted
Development
Systems (remote
sessions)

RequisitePro, Rose, SoDA, ClearCase, and ClearQuest support hosted
development on these platforms:
� Citrix
� Windows Terminal Server (Windows NT 4)
� Windows 2000 Server

Microsoft Visual
Basic

6.0 Service Pack 3 or higher (Visual Studio 6.0)

Rational Test products support V5.0.

Microsoft Visual C++ 6.0 (Visual Studio 6.0)

Rational Test products support V5.0.

Microsoft Word 97 Service Release 2 or 2000 Service Release 1

Microsoft Excel 97 Service Release 2 or 2000 Service Release 1

Table 5 Rational Suite Requirements (continued)

Item Minimum Requirements
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Web Browsers � Internet Explorer 4.01 Service Pack 1 or higher

Certain Rational products require components from Internet
Explorer 4.01 to run correctly. However, you are not required to use
Internet Explorer for your browser.

If you do not have Internet Explorer, you can download it from
Microsoft's Web site: http://www.microsoft.com/windows/ie. If
the Rational installer does not detect that Internet Explorer 4.01 is
already installed on your system, it does not allow the installation to
proceed.

� Netscape Navigator 4.6 or 4.7 (Windows 98/NT, UNIX)

Note: Rose Add-ins that use a Web browser (for example, Rose Web
Publisher) support most common Web browsers.

Web Servers � ClearCase IIS 5, 4, Apache, Netscape
Note: In addition to enough free disk space to load ClearCase LT
server, the server needs 0.5 to 1.0 MB for each user who will use the
ClearCase Web interface through the ClearCase LT server.

� ClearQuest IIS 5, 4
� RequisitePro IIS 5, 4, Apache
� TestManager IIS 5, Microsoft Personal Web Server from Windows

NT 4.0 Option Pack

Web Servers on
Non-Windows
Platforms

� ClearCase
Apache on Solaris 2.51 or higher, or on HP-UX 10.20 or higher

� RequisitePro
Apache on Solaris 8, Red Hat Linux 7

Web Clients on
Non-Windows
Platforms

ClearCase, ClearQuest, RequisitePro, Rational Unified Process, Rose
Web Publisher

Netscape 4.6 or higher on Solaris 2.51 or later, or on HP-UX 10.20 or
higher

SQL Anywhere
Server

Sybase SQL Anywhere is available on the Rational Solutions for
Windows CD-ROM Disc 1 or 2, but it is configured to work only with
Rational products.

Operating system: Windows 2000, Windows NT 4.0 Server, or
Workstation 4.0
� Processor: Pentium
� Memory: 64 MB
� Disk space: 100 MB (minimum)
� Network protocol: TCP/IP

Note: Novell NetWare is no longer supported for network servers.

Table 5 Rational Suite Requirements (continued)

Item Minimum Requirements
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ClearQuest
Databases

� DB2 6.1
� Microsoft Access 2000
� SQL Server 6.5 Service Pack 5, 7.0 Service Pack 2, or 2000
� SQL Anywhere 5.5.05
� Oracle 7.3.4, 8.0.5, 8.1.6, 8.1.7
� DB2 7.1

RequisitePro
Databases

� Access 2000
� SQL Server 7.0 Service Pack 2, or 2000
� Oracle server 7.3.4, 8.1.6, or 8.1.7

Oracle client 7.3.4, 8.1.6, or 8.1.7
Note: If you are using a version 7.3.4 server, we recommend that
you use a version 7.3.4 client.

� 96 MB disk space
� 128 MB minimum memory; for projects with approximately 50,000

requirements, 256 MB memory is recommended.
Memory requirements vary depending on the number of
concurrent users, the amount of data being requested, and the size
of the database.

Rose Data Modeler
Databases

� DB2 Universal Database 5.x, 6.x, or 7.x
� DB2 OS390 5.x or 6.x
� SQL Server 6.x or 7.x
� Oracle 7.x or 8.x
� Sybase System 12
� To reverse engineer Oracle and DB2 databases using Rose Data

Modeler, an RDMS client must be installed.

Monitor SVGA-compatible display with 256 or more colors
Minimum resolution: 1024 x 768 pixels
Recommended resolution: 1280 x 1024 pixels

Mouse/Pointing
Device

Microsoft Mouse or compatible pointing device with at least 2 buttons

Dual Boot Systems Installation of Rational Suite on dual-boot systems is not supported

Archive Utility WinZip or equivalentb

Rational
Documentation

Adobe Acrobat Reader 4.x or higher to read online PDF files

Table 5 Rational Suite Requirements (continued)

Item Minimum Requirements
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Installing Rational Suite

Here is a list of requirements for installing Rational Suite for the first time at your site.

1 You cannot run a Rational product without a license key. See Administering Licenses
for Rational Software on page 23.

2 If you are setting up a Rational Suite installation with Unified Change
Management, see Using Unified Change Management with Rational Suite.

3 Read the Configuring Rational Suite manual to plan your Rational product
integrations, such as Rational RequisitePro and Rational ClearQuest, and to plan
how you will use the Rational Administrator and the Rational Synchronizer.

❑ The Rational Software Setup program automatically installs Rational
Administrator with Rational RequisitePro, Rose Enterprise, Robot, and
TestManager. If any of these point products are included in your Rational Suite,
you will see the Rational Administrator in your Start menu.

❑ The Rational Software Setup program installs the Rational Synchronizer only in
Rational Suite installations.

4 Read the product-specific sections for the tasks required to install features that are
part of your Rational Suite. See Products in Each Rational Suite on page 20 to find
out which products are in your Rational Suite.

5 Read the following topics about the Rational Software Setup program: Selecting an
Installation Type on page 25 and Installing Shared Files on page 26.

6 If you are upgrading from an individual Rational product to a Rational Suite, see
Ensuring Version Compatibility on page 27.

Rational Suite Documents

This installation section refers to the following manuals in the Rational Solutions for
Windows Documentation CD-ROM:

� Administering Licenses for Rational Software
� Configuring Rational Suite
� Using Unified Change Management with Rational Suite
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Rational ClearCase LT – Before You Install

The following sections provide an overview of tasks you must perform before you
install ClearCase LT as part of Rational Suite. These ClearCase LT requirements are in
addition to the list of requirements for running the Rational Software Setup program
and installing Rational Suite.
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ClearCase LT System and Software Requirements

Table 6 lists additional system and software requirements for installing ClearCase LT
as part of Rational Suite. If you do not see an item listed in Table 6, see Table 5 on
page 32. See Installing Rational ClearCase LT for standalone installation requirements.

Administering Licenses for ClearCase LT

The following describes requirements and options for licensing ClearCase LT as part
of Rational Suite. For information about installing the license server and license keys,
see the Administering Licenses for Rational Software manual.

� The ClearCase LT server requires a floating license except when you are installing
it for evaluation.

� Install the license server and ClearCase LT server on different systems.

Table 6 ClearCase LT Requirements

Item Minimum Requirements

Operating System ClearCase LT client only:
Windows 98 all versions
Windows Me

Windows 98

Windows Millenium Edition

� Client for Microsoft Networks (shipped with
both platforms)

� TCP/IP (shipped with both platforms)
� Windows Sockets 2 (shipped with Windows 98)

Supported File Systems:
� Windows NT
� Windows 98
� Windows 2000

FAT, NTFS, LANMAN, NFS

FAT, FAT32

FAT, FAT32, NTFS, LANMAN

ClearCase LT client Disk Space ClearCase LT client is included in Rational Suite.
The client also needs enough disk space to contain
all files loaded into snapshot views and all
view-private files added to the views. The amount
of space required depends on the number and
sizes of the files in the views.
38 Chapter 2 - Before You Install – First Time Installation



Installing ClearCase LT

Here is an overview of tasks for installing ClearCase LT as part of Rational Suite for
the first time. See Installing Rational ClearCase LT for detailed procedures.

Note: If you have installed ClearCase on any system that you intend to use as a
ClearCase LT client or server, you must remove ClearCase on those systems before
you install ClearCase LT. If you continue with your installation of Rational Suite
(includes ClearCase LT client) on that system, the Setup program will install every
Rational product within Rational Suite, except ClearCase LT client, on that system.

1 UCM is Rational Software’s approach to managing change in software system
development from requirements to release. It is an out-of-the-box change
management process layered on top of Rational ClearCase and Rational
ClearQuest. You can use Rational ClearCase LT with or without UCM. For more
information about this choice, see Introducing Rational ClearCase LT.

To learn how to set up a networking environment so you can use UCM with
Rational Suite products, read about setting up UCM in Using Unified Change
Management with Rational Suite. We recommend that you read about setting up
UCM before you continue this installation.

For information about the Rational ClearQuest integration with UCM, see
Managing Software Projects with ClearCase.

2 ClearCase LT is a client/server product. To use a ClearCase LT client, a
ClearCase LT server must be installed in the same network domain as the clients.

❑ The ClearCase LT server requires a separate installation. To select a ClearCase
LT server system, see Installing Rational ClearCase LT for guidelines.

❑ A ClearCase LT client can access only one server.

❑ ClearCase LT client is included in Rational Suite installations. The Rational
Software Setup program will ask for the ClearCase LT server name when you
install Rational Suite.

3 For optimal performance, we strongly recommend installing the ClearCase LT
server on a dedicated system. However, if you are evaluating ClearCase LT or
working in a small team, you can install ClearCase LT server and Rational Suite on
the same system.

❑ To install the ClearCase LT server and Rational Suite on the same system, install
the ClearCase LT server first. When you install Rational Suite on the same
system afterward, the Rational Software Setup program excludes the ClearCase
LT client software. In a typical Rational Suite installation, the ClearCase LT
client is included.
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❑ To evaluate ClearCase LT, use only the ClearCase LT server because the server
includes client software.

4 The systems on which you plan to install ClearCase LT must be members of a
Windows NT domain, and all users who will use ClearCase LT must have
accounts in a Windows NT domain.

5 Designate one domain group as the ClearCase Users Group. When you install
ClearCase LT server, you need to be a member of the ClearCase Users Group as
well as have administrator privileges (on page 24) to run the Server Setup Wizard
at the end of the installation (or after the restart). If you are not a member of the
ClearCase Users Group when you install ClearCase LT server, you will have to log
out and log in again as a member of the ClearCase Users Group to run the Server
Setup Wizard.

6 If you anticipate many users will access a single VOB more or less simultaneously,
install Windows NT or Windows 2000 server software on your ClearCase LT
server. A maximum of 10 systems can access a Windows NT or Windows 2000
Workstation simultaneously by means of file-system mounts or Uniform Naming
Convention (UNC).

7 You can install ClearCase LT server on any UNIX platform that ClearCase LT
supports. For a list of platforms that ClearCase LT supports, see the Rational
ClearCase LT Release Notes. For more information about interoperation between
Windows and UNIX, see Administering Rational ClearCase LT.

8 The Server Setup Wizard appears immediately after you install ClearCase LT
server if you have logged in using the correct permissions. Refer to Rational
ClearCase LT – After You Install on page 65 for an overview of Server Setup and
operating environment requirements.

ClearCase LT Documents

This initial installation section refers to the following documents in the Rational
Solutions for Windows Documentation CD-ROM:

� Installing Rational ClearCase LT
� Administering Rational ClearCase LT
� Introducing Rational ClearCase LT
� Rational ClearCase LT Release Notes
� Using Unified Change Management with Rational Suite
� Managing Software Projects with ClearCase
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Rational ClearQuest – Before You Install

The following sections provide an overview of tasks you must perform before you
install ClearQuest as part of Rational Suite. These ClearQuest requirements are in
addition to the list of requirements for running the Rational Software Setup program
and installing Rational Suite.

ClearQuest System and Software Requirements

See the Rational Suite requirements in Table 5 on page 32. The standalone system and
software requirements are listed in the Rational ClearQuest Release Notes.

Installing ClearQuest

Here is an overview of tasks for installing ClearQuest as part of Rational Suite for the
first time. For detailed procedures, see the Installing Rational ClearQuest manual.

Note: For improved performance, security, and reliability, we recommend that you
place the database server and the Web server on two different systems, each with its
software installed onto a Windows NT File System (NTFS) partition.

1 Set up an empty server database for the ClearQuest schema repository and at least
one empty database for the ClearQuest user database.

For guidelines on which type of database software would meet your needs and for
procedures for setting up the database software, see Installing Rational ClearQuest.

2 Select a system that has extra memory and disk space to become the ClearQuest
administrator’s system.

3 Use the Rational Software Setup program to install Rational Suite on the
ClearQuest administrator’s system and client systems.

4 If you or other users want to customize the defect reports that ship with
ClearQuest, install Crystal Reports on the ClearQuest administrator’s system and
client systems. To install Crystal Reports, use the Crystal Reports installation
directions that come with the separate Crystal Reports CD-ROM in your Rational
software shipment.

Note: A user who will not be editing existing report formats or creating new report
formats does not need to install Crystal Reports.
Rational ClearQuest – Before You Install 41



ClearQuest Documents

This installation section refers to the following ClearQuest documents in the Rational
Solutions for Windows Documentation CD-ROM:

� Installing Rational ClearQuest
� Rational ClearQuest Release Notes

Rational RequisitePro – Before You Install

The following sections provide an overview of tasks you must perform before you
install RequisitePro as part of Rational Suite. These RequisitePro requirements are in
addition to the list of requirements for running the Rational Software Setup program
and installing Rational Suite.

RequisitePro System and Software Requirements

See Table 5 on page 32. See Installing Rational RequisitePro for standalone installation
requirements.

Installing RequisitePro

Before installing RequisitePro, determine which database type you will use with
RequisitePro Projects. RequisitePro can be used with Oracle, Microsoft SQL Server,
and Microsoft Access databases. Refer to Oracle or Microsoft documentation for
information on installing Oracle or Microsoft SQL Server. If you are using an Oracle
database, you must also install the Oracle Client software on the client systems.

For more installation details, see the Installing Rational RequisitePro manual for
detailed procedures.

Note: The Rational Administrator is automatically installed with RequisitePro.

RequisitePro Documents

This installation section refers to the following documents in the Rational Solutions
for Windows Documentation CD-ROM:

� Installing Rational RequisitePro
� RequisiteWeb Installation and Configuration
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Rational Rose – Before You Install

The following sections provide an overview of tasks you must perform before you
install Rational Rose as part of Rational Suite. These Rose requirements are in addition
to the list of requirements for running the Rational Software Setup program and
installing Rational Suite.

Note: There are no post-configuration tasks for an initial installation of Rational Rose
as part of Rational Suite.

Rose System and Software Requirements

See Table 5 on page 32. Table 7 lists additional system and software requirements for
installing Rational Rose as part of Rational Suite. See Installing Rational Rose for
standalone installation requirements.

Installing Rose

Here is an overview of tasks for installing Rose as part of Rational Suite for the first
time.

Note: The Rational Administrator is automatically installed with Rose Modeler and
and Rose Enterprise.

� Before you install Rational Rose as part of Rational Suite for the first time, back up
model and property files and restore path map variables. For instructions, see
either the Back Up Guidelines section in the Installing Rational Rose manual or the
Getting Started section in the beginning of the Rational Rose Release Notes.

� To use Rose Data Modeler, see Table 5 on page 32 for the supported databases and
follow the database vendor’s documentation for configuration instructions. The
Using Rose Data Modeler manual does not provide database configuration
procedures.

Table 7 Rational Rose Requirements

Add-In Minimum Requirements

Rose Visual Basic Microsoft Visual Basic (Visual Studio 6.0)

Rose Visual C++ Microsoft Visual C++ (Visual Studio 6.0)

Rose J JDK 1.1.6 or any of the major Java IDEs
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� When installing Rose as part of Rational Suite on Microsoft Windows NT 4.0 SP6a
or Windows 2000, Rose may not run until you add the Rational\Common directory
to your user path. Use the procedure in the File Location Guidelines section in
Installing Rational Rose to add the directory to your user path.

� Rational Rose Add-ins are automatically installed with Rose Enterprise or Rose
Modeler in a Rational Suite installation.

If you do not want to install the Rose Add-ins:

a Select the Custom Installation Type in the Select Configuration dialog box.

b Deselect the Add-ins under Rose Enterprise or Rose Modeler in the Choose
Features dialog box.

Rose Documents

This installation section refers to the following documents in the Rational Solutions
for Windows Documentation CD-ROM:

� Installing Rational Rose
� Rational Rose Release Notes

Rational Rose RealTime – Before You Install

The following sections provide an overview of tasks you must perform before you
install Rational Rose RealTime as part of Rational Suite. These Rose RealTime
requirements are in addition to the list of requirements for running the Rational
Software Setup program and installing Rational Suite.

Note: There are no post-configuration tasks for an initial installation of Rational Rose
RealTime as part of Rational Suite.
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Rose RealTime System and Software Requirements

See Table 5 on page 32. Table 8 lists additional software requirements for installing
Rational Rose RealTime as part of Rational Suite. See Installation Guide - Rational Rose
RealTime (Chapter 3 Installing Rose RealTime on Windows) for standalone installation
requirements.

Installing Rose RealTime

Here is an overview of tasks for installing Rational Rose RealTime as part of Rational
Suite for the first time.

� Insert Rational Solutions for Windows Disc 2 to install Rose RealTime or Rational
Suite RealTime Edition.

� To generate and execute code with Rose RealTime, C++ compilers must be
installed on your system. See the Installation Guide - Rational Rose RealTime for a list
of supported compilers and targets.

� To construct and execute UML models, you must test your Visual C++
environment. To help you determine whether you have correctly installed and
configured Visual C++ on your system, see the Testing your Environment section in
the Installation Guide - Rational Rose RealTime.

� To deploy your model in a real-time operating system, see the Installation Guide -
Rational Rose RealTime for information about the supported line-ups.

Rose RealTime Documents

This installation section refers to Installation Guide - Rational Rose RealTime (Chapter 3
Installing Rose RealTime on Window) on Rational Solutions for Windows Disc 2.

Table 8 Rational Rose RealTime Requirements

Item Minimum Requirements

Development environment Visual Studio 5.0
Visual Studio 6.0, SP3 or SP4
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Rational Testing Products – Before You Install

This section provides an overview of tasks you need to perform before you install
Rational testing products and their related components as part of Rational Suite.
These requirements are in addition to the list of requirements for running the Rational
Software Setup program and installing Rational Suite.

For standalone installations of Rational testing products, including TeamTest, see
Installing Rational Testing Products for installation requirements.
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Rational Testing System and Software Requirements

See Table 5 on page 32. Table 9 lists additional system and software requirements for
installing TestManager and Test Agent as part of Rational Suite. See Installing Rational
Testing Products for standalone installation requirements.

Table 9 Rational Testing Products Requirements

Component Minimum Requirements

Rational TestManager � 1–3 MB RAM per virtual tester
� 1–3 MB disk space per virtual tester
� If you are running Visual Basic language test scripts, VB 6

on Windows 2000 or Windows NT is required.
� If you are running Java test scripts, the JDK (IBM version

1.1.7B or Sun Microsystems versions 1.2.2 or 1.3.0) is
required.

Rational Test Agent

– Windows Systems

� 150 MB free disk space for installation. We recommend
more disk space for large virtual tester runs.

� If you are running VB test scripts, Microsoft Windows NT
4.0 (Service Pack 5 or 6a) or Windows 2000 is required.

� If you are running Visual Basic language test scripts, VB 6
Service Pack 3 and Windows 2000, or VB 6 Service Pack 3
and Windows NT.

� If you are running Java test scripts, the JDK (IBM version
1.1.7B or Sun Microsystems versions 1.2.2 or 1.3.0).

� TCP/IP

Rational Test Agent

– UNIX Systems

� 32 MB memory, plus 0.5–2 MB per virtual tester (some
workloads may require more memory)

� 150 MB free disk space for installation. We recommend
more disk space for large virtual tester runs.

� One of the following operating systems:

AIX 4.3
HP-UX 11
DYNIX/ptx 4.5.1
Solaris 2.5, 2.6, or 2.7
Red Hat 6.x release of Linux

� If you are running Java test scripts, the JDK (IBM version
1.1.7B or Sun Microsystems versions 1.2.2 or 1.3.0).
Rational Testing Products – Before You Install 47



Administering Licenses for Rational Testing Products

This section describes the types of licenses you need in order to Rational testing
products.

� Rational Suite TestStudio requires floating licenses.

� To record GUI test scripts on multiple computers, you need to install Rational
Robot outside of Rational Suite on each computer. A separate node-locked license
is required for Robot-only installations.

For more information about Rational Software licensing, see Administering Licenses for
Rational Software.

Installing Rational Testing Products

This section provides an overview of tasks for installing Rational testing products as
part of Rational Suite for the first time. For more information about Rational testing
products and features, see the Installing Rational Testing Products manual.

1 Previous versions of Rational LoadTest and Rational Suite PerformanceStudio will
not work with testing products from this release. You must uninstall them first.

2 If SQA Suite 6.x is installed on your computer, you do not have to uninstall it. The
current version of Rational testing products and SQA Suite 6.x. can coexist because
they are installed in different directories.

3 Make sure that all computers have TCP/IP installed. If you have updates to your
network software that you have not installed, be sure to install the upgrades.

4 Verify that the Windows systems are communicating with each other. (If you have
any problems, see your network administrator.)

5 Determine a database type for Rational ClearQuest. See Installing Rational
ClearQuest for more information.

6 Rational Test Samples Setup is automatically installed in a Typical installation of
Rational Robot, TestStudio, and EnterpriseStudio. These files let you evaluate a
sample application, applets, and Rational project.

See Installing Rational Testing Products for a description of these files and for setup
instructions.
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7 To play back a TestStudio script that tests Oracle, Sybase, or SQL Server databases
on a Local or Agent computer, you must install the appropriate database client
software before you install TestStudio software. For information, see Installing
Rational Testing Products.

Note: Do not install any Rational testing products until you have installed the
database client software.

8 Determine the role each system will play in testing—whether it will be a Local
(Rational Suite) or an Agent system. For a description of these roles, see Installing
Rational Testing Products.

a After you install the Rational Suite on a Local system, use the Rational Software
Setup program to install Rational Test Agent on Agent systems. To do this,
select Rational Test Agent in the Choose Product dialog box.

b To install Test Agent software on a UNIX system, see Installing Rational Testing
Products.

Note: The same version of Rational testing software must be installed on the Local
and Agent computers; otherwise, they will not work together.

9 Determine the kind of network you will be using, either Ethernet or Token Ring.
You need this information when you install the Rational Test network driver. For
information, see “Installing the Rational Test Network Driver” in Installing Rational
Testing Products.

10 To install ClearQuest Web, see Before You Install – Web Component Installation on
page 53.

11 Use the Rational Administrator to create your test datastores. The Rational
Administrator is automatically installed with Robot and TestManager. See the
Using the Rational Administrator manual for more information.

Documents for Rational Testing Products

This installation section refers to Installing Rational Testing Products and Using the
Rational Administrator in the Rational Solutions for Windows Documentation
CD-ROM.
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Rational Unified Process – Before You Install

This section provides an overview of tasks you need to perform before you install the
Rational Unified Process (RUP) as part of Rational Suite. These requirements are in
addition to the list of requirements for running the Rational Software Setup program
and installing Rational Suite.

Note: There are no post-configuration tasks for the RUP.

Rational Unified Process System and Software Requirements

See Table 5 on page 32. For standalone installation requirements, see Installing the
Rational Unified Process.

Installing Rational Unified Process

This section provides an overview of tasks for installing the Rational Unified Process
as part of Rational Suite for the first time. For more information about the variants of
the RUP, see Installing the Rational Unified Process.

� To install the RUP, select the Typical Installation type in the Rational Software
Setup program.

� To install the RUP for the Microsoft Web Solution Platform:

a Select the Rational Suite under Choose Product in the Rational Software Setup
program.

b Select the Custom Installation Type.

c Under Rational Unified Process, select (variant) with content for the Microsoft
Web Solution Platform.

d Leave the (core) Rational Unified Process [required] selected.

� To install the RUP with IBM e-Business content:

a Select the Rational Suite under Choose Product in the Rational Software Setup
program.

b Select the Custom Installation Type.

c Under Rational Unified Process, select (variant) with IBM content for e-Business.

d Leave the (core) Rational Unified Process [required] selected.
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Rational Unified Process Documents

This installation section refers to Installing the Rational Unified Process in the Rational
Solutions for Windows Documentation CD-ROM.
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3Before You Install – Web
Component Installation
Rational Suite Web server components give users who do not have Rational Suite on
their systems the opportunity to access project data. This chapter provides an
overview of requirements for installing Rational Suite Web components for the
following point products: Rational ClearCase LT, ClearQuest, RequisitePro, and
TestManager. You can install all of these Web components from Rational Solutions for
Windows Disc 1.

The Rational Unified Process and Rose Web Publisher are also Web applications, but
you do not have to install Web server components or configure Web server software in
order to use them.

Administering Licenses for Web Applications

Some of the Rational Web applications require license keys:

� To get full ClearQuest Web and RequisiteWeb access, you need to use floating
licenses. For more information about installing floating license keys, see
Administering Licenses for Rational Software manual.

� To use the ClearCase Web interface, use the same license type that you purchased
for the ClearCase LT server. For more information about ClearCase LT licensing,
see Administering Licenses for ClearCase LT on page 38.

ClearCase Web Interface – Before You Install

To run the ClearCase Web interface, you need to configure third-party Web server
software. ClearCase LT Web components are included in the ClearCase LT server
installation.

ClearCase Web Interface System and Software Requirements

Table 5 on page 32 lists the supported Web server software and browsers. If you use a
Windows NT Web server, the server must run as a service and it must be configured
to log on as the System account. This is the default for Microsoft and Netscape Web
servers.
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To provide a secure port through which to access ClearCase, the ClearCase Web
interface can run through a secure port using Secure Socket Layer (SSL).

For more information about changing the location of view storage directories and
limiting the size of uploaded files, see the “ClearCase Considerations” section in
“Configuring a Web Server for the ClearCase Web Interface” in Administering
ClearCase LT.

Installing ClearCase Web Interface

Because the ClearCase LT Web server components are part of the ClearCase LT server
installation, you can perform the Web server configuration after you have installed
and configured the ClearCase LT server.

1 To access ClearCase Web from clients, install one of the Web browsers listed in
Table 5 on page 32. Users do not have to disable cookies on the Web clients. No
additional software is required to use the ClearCase Web interface.

2 To set up the ClearCase Web interface through Apache, Microsoft Internet
Information Server, or Netscape Enterprise Server software, see ClearCase Web –
After You Install on page 71.

ClearQuest Web – Before You Install

You can install the ClearQuest Web server and the RequisiteWeb Requirements server
on the same system. ClearQuest Web requires installing ClearQuest Web server
components and setting up the ClearQuest Web server.

ClearQuest Web System and Software Requirements

Table 5 on page 32 lists the supported Web server software and browsers.

Installing ClearQuest Web

Use the following instructions to install the ClearQuest Web components.

Note: For improved performance, security, and reliability, we recommend that you
place the database server and the Web server on two different systems, each with its
software installed onto an NTFS partition.
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1 To install the ClearQuest Web components on the Web server:

a Select a Rational Suite edition or Rational ClearQuest under Choose Product in
the Rational Software Setup program.

b Select the Custom Installation Type in the Select Configuration.

c In the Choose Features dialog box, select ClearQuest Web Under Web Server
Components.

d If you do not want Rational Suite or the ClearQuest application installed on the
Web server, clear the check boxes for ClearQuest and other Rational Suite point
products.

2 To access ClearQuest Web from client systems, install one of the Web browsers
listed in Table 5 on page 32. Users need only browsers with cookies enabled to use
ClearQuest Web clients. No additional software is required to use ClearQuest Web.

3 Configure the ClearQuest Web server, set up e-mail notification for the Web clients,
and provide users with the path to ClearQuest Web. See an overview of the
requirements in ClearQuest Web – After You Install on page 72.

RequisiteWeb – Before You Install

You can install the ClearQuest Web server and the RequisiteWeb Requirements server
on the same system. RequisiteWeb requires installing Web server components and
setting up a Web server configuration.

RequisiteWeb System and Software Requirements

Table 5 on page 32 lists the general requirements for a RequisiteWeb Requirements
Web server on Windows and UNIX.

Installing RequisiteWeb

To set up RequisiteWeb, choose from the following possible Web server
configurations:

� If you use Microsoft Internet Information Server (IIS) on Windows NT 4.0 or
Windows 2000 on your Web server, you can configure a single Windows server for
your RequisiteWeb Requirements server.

� If you use Linux or Sun Microsystems Solaris for an operating system on your Web
server, you must configure a both your UNIX Web server and another Windows
server for managing the RequisiteWeb artifacts.
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An overview of these components, configurations, and set-up instructions are also
provided in the RequisiteWeb Installation and Configuration document that is on the
Rational Solutions for Windows Disc 1 at \RequisitePro\ReqWeb\reqwebsetup.html. The
RequisiteWeb Installation and Configuration document is also available from the online
Release Notes in RequisitePro.

Use the following instructions to install and configure the RequisitePro Web
components on the RequisiteWeb Requirements server:

1 Select a Rational Suite edition or RequisitePro under Choose Product in the
Rational Software Setup program.

2 Select the Custom Installation Type in Select Configuration.

3 In the Choose Features dialog box, select RequisiteWeb under Web Server
Components.

4 Select or clear the following optional check boxes:

� The RequisiteWeb Sample Projects are helpful for testing and learning
RequisiteWeb.

� If you do not want other Rational Suite point products installed on the Web
server, clear the check boxes for these products.

5 To access RequisiteWeb from client systems, install one of the Web browsers listed
in Table 5 on page 32. Users need only browsers with cookies enabled to use
RequisiteWeb clients. No additional software is required to use RequisiteWeb.

6 Configure the RequisiteWeb Requirements Server, set up e-mail notification for the
Web clients, and provide users with the path to RequisiteWeb. See RequisiteWeb –
After You Install on page 72.

ManualTest Web Execution – Before You Install

The Rational ManualTest Web Execution component of TestManager requires you to
install and configure ManualTest Web Execution software on a Web server and
configure a Web browser on each client to access a Rational project.
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ManualTest Web Execution System and Software Requirements

ManualTest Web software supports additional Windows operating systems. Table 5
on page 32 lists the Web browsers needed to access the Web server from a client.

Note: We recommend that you use Windows 2000 Server, Windows 2000 Advanced
Server, or Windows NT 4.0 Server, as the Web server platform. You can not use a
shared or networked project with the Windows 2000 Professional or Windows NT 4.0
Workstation.

Installing ManualTest Web Execution

You do not need to install a Rational testing product on the Web server unless you
want to create manual test scripts on the Web server. The Manual Test Web Execution
component installs by default when you install any of the Rational testing products
included in your Rational Suite. For complete instructions, see the Using Rational
TestManager manual.

To install the ManualTest Web Execution components on the Web server:

1 After you select Rational Suite under Choose Product in the Rational Software
Setup program, do one of the following on the Select Configuration page:

a If you do not want to create manual test scripts on the Web server and want to
set up a Web server:

i Select the Custom Installation Type.

ii Clear all check boxes in Choose Features.

iii Select the Web Server Components check box.

iv Select the Rational ManualTest Web Execution check box.

b If you want to create manual test scripts on the Web server, select Typical.

For Install

All versions of Windows 2000 Microsoft Internet Information Services 5.0 (IIS 5.0)
from the Windows 2000 CD-ROM

Windows 98, Windows 95, or
the Windows NT 4.0
Workstation

Microsoft Personal Web Server (PWS) from the
Windows NT 4.0 Option Pack (available from
Microsoft, www.microsoft.com)

Windows NT 4.0 Server Microsoft Internet Information Server (IIS) from the
Windows NT 4.0 Option Pack (available from
Microsoft, www.microsoft.com)
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2 To configure the Web server software, see the Using Rational TestManager manual.

3 After installing the ManualTest Web Execution component and configuring the
Web server software, set up the Web browser on the clients. See the Using Rational
TestManager manual for more information.
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4Installing Rational Suite
This chapter describes a typical or custom installation of Rational Suite. You use the
Rational Software Setup program for initial and upgrade installations.

Some products within Rational Suite may need to be removed or may require backups
or test upgrades before you upgrade the Rational Suite. See Upgrading from Earlier
Versions of Rational Suite on page 73 for upgrade requirements.

Using the Rational Software Setup Program

The Rational Software Setup program installs Rational Software products, including
Rational Suite.

You can install Rational license keys before or after you install a Rational product. To
install a license key before you install a Rational product, open the Rational License
Key Administrator by clicking the Configure Licenses button in the Choose Product
dialog box. Use the Rational License Key Administrator Help or see the Administering
Licenses for Rational Software manual for information about requesting and installing
license keys.

1 If you are installing on a Windows NT or Windows 2000 system, make sure you
have administrator privileges on the local system. For more information, see
Administrator Privileges on page 24.

2 Insert the Rational Solutions for Windows Disc 1 or 2 into your system’s CD-ROM
drive.

The Rational Software Setup program starts automatically.

If autorun is disabled on your system, click Start > Run and enter
drive: \Setup.exe where drive is the letter of the CD-ROM drive.

3 The Rational Software Setup dialog box provides general information about the
software installation.
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4 Choose the edition of Rational Suite that you want to install from the Choose
Product dialog box. A green check mark next to a Rational product indicates you
have a license key configured for that product. If you do not see a green check
mark next to the product you want to install, you may want to install license keys
before you install the product.

To configure a license key, click the Configure Licenses button to launch the
Rational License Key Administrator (LKAD) and the License Key Administrator
Wizard. If you do not install the license keys before you install the product, the
LKAD will appear at the end of the installation.

5 Choose to accept or not accept the Rational Software license agreement in the
License Agreement dialog box.

❑ If you accept the license agreement, the Setup program continues.

❑ If you do not accept the license agreement, exit the Setup program by clicking
Finish or Cancel. When you exit from the Setup program, the Setup program
makes no changes to the system (unless you have used the Rational License
Key Administrator to install a license key file or use a Rational license server).

6 Select an installation type in the Select Configuration dialog box. The installation
types are described in Table 2 on page 25. If you need to install the feature
component of a Rational Suite, select Custom and go to Step 7 on page 61.

If you select any other installation type, see Confirm Sufficient Free Space for the
Installation on page 60 before you click Next.

To enable all installation type options, remove all Rational Software products from
the system and then restart the Setup program.

Confirm Sufficient Free Space for the Installation

If the amount of free space is less than the amount required, either

� Exit from the Setup program and make more space available on the
specified disk, or

� Specify an alternate Install Path. Type the new path in the Install Path field or
use the Browse button to select a drive and directory.

If a Rational product has been previously installed with the Rational Software
Setup program, the Browse option and Install Path field are disabled. To enable
these options, remove all Rational products from the system, then reinstall the
products.
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7 After you choose Custom, specify which features to install on your system in the
Choose Features dialog box. Click the + in front of products and features to expand
options, then select or clear options. There are dependencies between some
products that may force an installation option, even if you have cleared it.

Table 10 lists where the features are located in the Choose Features dialog box.

Note: Before you click Next, see Confirm Sufficient Free Space for the Installation on
page 60.

8 You may see one or more of the following dialog boxes before you see the
Confirmation dialog box in Step 9 on page 62.

Table 10 Choose Features Options

Check Box (in Rational Software
Setup)

Notes

ClearQuest >
Administration Tools

Deselect Client Installation. Select or deselect other
options if appropriate.

ClearQuest >
Client Installation

Clear Administration Tools. Select or deselect other
options if appropriate.

ClearQuest > Web Server
Components > ClearQuest Web

Deselect the ClearQuest check box.

RequisitePro >
Oracle Setup or
SQL Server

Deselect other options.

RequisitePro > Web Server
Components > RequisiteWeb

Select the RequisiteWeb Sample Projects for testing
option if appropriate.

� Rational Suite > Web Server
Components > ManualTest Web
Execution

� Robot > Web Server Components
> ManualTest Web Execution

� TestManager > Web Server
Components > ManualTest Web
Execution

If you do not want to create manual test scripts on
the Web server and want to set up a Web server:

1 Clear all check boxes on Choose Features.

2 Select the Web Server Components check box.

3 Select the Rational ManualTest Web
Execution check box.

Rational Unified Process >
(variant) with IBM content for
e-Business

Leave the (core) Rational Unified Process
[required] selected.

Rational Unified Process >
(variant) with content for the
Microsoft Web Solution Platform

Leave the (core) Rational Unified Process
[required] selected.
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Update Shared Components

The Update Shared Components dialog box appears if the Setup program needs to
update shared files or components on your system. Click Next to have the Rational
Software Setup program install these files for you or Cancel to install these files
yourself. For additional information, see Installing Shared Files on page 26 or the
Rational Software Setup online Help.

The Setup wizard does not recalculate the disk space required for your updated
selections.

Upgrade Compatibility

The Upgrade Compatibility dialog box appears if you have older Rational products
installed on your system. For each of the older products listed, we strongly
recommend that you do one of the following:

❑ Upgrade it: Complete this installation, and then restart the Setup program to
upgrade the listed products.

❑ Remove it: Complete this installation, and then see Removing Rational Suite on
page 117 to remove the listed products from the system.

For more information, see Ensuring Version Compatibility on page 27.

9 The Confirmation dialog box displays the product features to be installed.

Warning: Interrupting the installation after you have confirmed the product
features to be installed may leave your system in an indeterminate state.

10 The Error Summary dialog box displays errors from the first part of the software
installation. If the installation is successful, this dialog box does not appear.

The Rational Software Setup program writes a log of installation messages in
<Install Path>\Rational\RSSetup\RSSetup.log.
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Possible Reboot Required

If files required for the installation are in use during the Rational Software Setup
program, and if the program needs to install shared components on your system, the
Setup program may need to reboot your system. After rebooting, do the following:

1 Log on as the same administrator identity to complete the installation procedure. If
you do not log on as the same administrator identity, the installation does not
complete correctly.

The installation process completes on your system.

2 Click Finish to exit from the Rational Software Setup program.
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5After You Install – First
Time Installation
This chapter provides an overview of tasks you must perform after you’ve installed
Rational Suite. Each product section may include information about configuring
databases, e-mail, and Web products, installing additional software, and setting up
product integrations.

Rational ClearCase LT – After You Install

After you install ClearCase LT server and ClearCase LT client, you must configure the
server, import existing files into ClearCase LT control, and make adjustments to the
operating environment. For more information about each of the following tasks, see
the Installing Rational ClearCase LT manual.

1 The Server Setup Wizard runs automatically at the end of a ClearCase LT server
installation if you ran the Rational Software Setup as a user who is a member of the
local administrator’s group and who is also a member of the ClearCase users
group. To install Rational Suite (which includes ClearCase LT client) on client
systems before you configure the ClearCase LT server, cancel the wizard and run it
later. See Installing Rational ClearCase LT for more information.

2 To import files and directories or convert files from another configuration
management system into ClearCase version control, use the Import Wizard option
in the Server Setup Wizard. The Import Wizard places these files and directories in
the VOB that the Server Setup creates.

3 After you set up the ClearCase LT server, you can perform administrative tasks on
the VOB and view storage directories. See Administering ClearCase LT for more
information.
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4 Make these adjustments to the client and server systems:

a Set the CLEARCASE_PRIMARY_GROUP environment variable for each user.

b Reset the language environment on the client to match the environment on the
server if one of the language settings uses single-byte encoding and the other
uses double- or multi-byte encoding.

For more information, see Installing Rational ClearCase LT.

5 Instruct each user to create views to access data on the ClearCase LT server.

ClearCase LT Documents

You can find the following ClearCase LT documents in the Rational Solutions for
Windows Documentation CD-ROM:

� Installing Rational ClearCase LT
� Administering Rational ClearCase LT

Rational ClearQuest – After You Install

The following overview assumes that you have set up empty vendor databases and
that you and your users have installed ClearQuest as part of Rational Suite on your
systems. For more information about the following tasks, see Installing Rational
ClearQuest.

1 On the ClearQuest administrator’s system, performing the following tasks:

a Create the ClearQuest databases that your users will use with ClearQuest. You
will create the master database or schema repository with the ClearQuest
Maintenance Tool first, and then create the user database(s) with the
ClearQuest Designer.

b Set up the configuration management integrations with Rational ClearCase or
Rational ClearCase LT. Within ClearCase, use the ClearQuest Integration
Configuration tool. Within ClearQuest, use the Package Wizard to apply the
ClearCase package to a schema. See the Administering Rational ClearQuest
manual for more information.

� To use the ClearQuest/ClearCase UCM integration, consult the Managing
Software Projects with ClearCase and the Administering Rational ClearQuest
manuals.

� To set up the integration with Microsoft Visual SourceSafe, use the Package
Wizard to apply the Visual SourceSafe integration package to a schema.
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c Configure the Rational E-mail Reader application to allow users to submit and
modify records via e-mail. Setting up Rational E-mail Reader is different from
enabling e-mail notification in ClearQuest Web. The E-mail Reader is an e-mail
processing tool that is automatically installed in the \Rational\common\ directory.
To set up the E-mail Reader, see the mailreader.hlp in the same directory.
For more information about the E-mail Reader, see the Administering Rational
ClearQuest manual.

2 See the Administering Rational ClearQuest guide for details on customizing
ClearQuest.

3 On each client system, instruct users to perform the following tasks:

a Connect to the schema repository.

b Enter the database properties information or load the user profile file
(cqprofile.ini) that you have created for them.

c Enable e-mail notification through the ClearQuest main menu.

ClearQuest Documents

You can find the following documents in the Rational Solutions for Windows
Documentation CD-ROM:

� Installing Rational ClearQuest
� Administering Rational ClearQuest
� Managing Software Projects with ClearCase

Rational RequisitePro – After You Install

After installing RequisitePro, you can perform the following configuration tasks:

� To use RequisitePro discussions for managing communication between your
project team members, configure e-mail discussions that are integrated with your
RequisitePro project. For detailed instructions, see “Configuring E-mail for
Discussions” in Installing Rational RequisitePro.

� To use an enterprise database (Oracle or Microsoft SQL Server) to contain your
RequisitePro project data, configure your database schema using the scripts and
instructions that are included with the Custom installation option, as described in
Using the Rational Software Setup Program on page 59. For more information, see
“Configuring Enterprise Databases” in Installing Rational RequisitePro.
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RequisitePro Documents

You can find Installing Rational RequisitePro in the Rational Solutions for Windows
Documentation CD-ROM.
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Rational Testing Products – After You Install

Table 11 lists the additional components that you may need to install for Rational
testing products that are part of Rational Suite. For complete installation procedures,
see Installing Rational Testing Products.

Rational Testing Documents

You can find Installing Rational Testing Products on the Rational Solutions for Windows
Documentation CD-ROM.

Table 11 Additional Installations

To Install

Test ActiveX controls, Java applets,
Oracle Forms, and Visual Basic
applications

Rational Test Enablers:
� Rational ActiveX Test Control
� Rational Test Java Enabler
� Rational Test Oracle Forms Enabler
� Rational Test Visual Basic Enabler

Record sessions over a network Rational Test network driver

Determine the kind of network you will be
using, either Ethernet or Token Ring. You need
to know this information to install the network
driver.

Record GUI test scripts on multiple
computers

Rational Robot as a standalone product on each
computer
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6After You Install – Web
Component Installation
This chapter provides an overview of tasks for configuring Rational Suite Web servers
for the following point products: Rational ClearCase LT, ClearQuest, and
RequisitePro.

ClearCase Web – After You Install

This section provides an overview of configuration instructions for the Web server
software you have selected to run the ClearCase Web interface. For detailed
instructions, see “Configuring a Web Server for the ClearCase Web Interface” in
Administering ClearCase LT.

1 For each configuration you need to know the ccase-home-dir and ccbase-url.

The ccase-home-dir is the location of the ClearCase installation directory, by default:

❑ C:\Program Files\Rational\ClearCase on Windows NT

❑ /usr/atria on UNIX

The ccbase-url is the base URL for the interface. It can be any arbitrary string, for
example, ccaseweb or ccweb. The full pathname for the Web interface is:

❑ http://server-name/ccbase-url/bin/ccweb.exe on Windows NT

❑ http://server-name/ccbase-url/bin/ccweb on UNIX

If the server is on a secure port, the full ClearCase URL begins with https rather
than http.

2 You will find detailed configuration tasks for Apache, Microsoft Internet
Information Server (IIS), and Netscape Enterprise Server in “Configuring a Web
Server for the ClearCase Web Interface” in Administering ClearCase LT.

3 Provide client users with the full pathname for the Web interface after you have
configured the ClearCase LT Web server.
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ClearQuest Web – After You Install

This section provides an overview of configuration instructions for the ClearQuest
Web server. See Installing Rational ClearQuest for detailed instructions.

1 Create an anonymous user account for IIS to use when it serves the ClearQuest
pages.

If you are using a SQL Server database, the anonymous user account should be
known in the domain that contains the ClearQuest database and should have full
access to that database.

a Set up the access key registry privileges.

b Set up the read access permission to the directory tree containing the
ClearQuest Web files (WWW directory in the ClearQuest installation area).

2 Create and edit a cache directory in the ClearQuest Web directory hierarchy.

3 Create and edit a virtual directory for the Web.

4 Edit the properties of the images subdirectory.

5 Restart the Web server.

6 Enable e-mail notification support for Web clients on the Web server.

7 Set up registry key access privileges on the Web server.

8 Give users on Web clients the URL for ClearQuest Web.

RequisiteWeb – After You Install

To configure RequisiteWeb, refer to “Installing and Configuring RequisiteWeb” in
Installing Rational RequisitePro. The instructions are also available in the
RequisiteWebInstall.html file, which is included in your RequisiteWeb installation. It
is also available from a link in your RequisitePro online release notes.
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7Upgrading from Earlier
Versions of Rational Suite
To continue using data that you created in earlier versions of Rational Suite, you need
to upgrade your software and datastores in a specific order. If you are upgrading from
an earlier version of Rational Suite to the current version, Version 2001A.04.00, read
this chapter to understand how to upgrade successfully.

The information in this chapter collects and supersedes information available in
documentation for individual products. Any changes made after this book went to
press are recorded in the Rational Suite Release Notes.

Table 12 describes how to proceed, based on the version of Rational Suite that is
currently installed on your network.

Overview of Upgrading

This chapter describes how to perform the following tasks:

� Instruct users to stop work on Rational products.
� Prepare to upgrade.
� Install new software on servers and clients.
� Upgrade installed products, including their datastores.
� Instruct users to reconnect to Rational ClearQuest and resume work.

Table 12 Upgrading Rational Suite

If you are starting from this version Then upgrade as follows

Rational Suite 2001.03.00 Follow the procedures in this chapter.

Rational Suite 2000.02.10 Follow the procedures in this chapter.

Rational Suite 1.5, 1.1, or 1.0 1 Upgrade to version 2000.02.10, following the
procedure supplied by Rational Technical Support.

2 Upgrade to the current version by following the
procedures in this chapter.

A Rational point product, any
version

Contact Technical Support for more information.
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Note: If you have problems with the steps in this chapter, contact Rational Technical
Support.

Preparing to Upgrade

To prepare to upgrade to the current version of Rational Suite, perform these tasks:

� Plan your upgrade.

Design the upgrade process so that you upgrade software and datastores, and then
test. If you are planning major changes to your environment, perform them after
determining that the upgrade is successful. Do not attempt to make major changes
to your Rational Suite environment in the middle of the upgrade. An example of a
major change is switching a vendor database or enabling a project for use with
Unified Change Management.

� Back up your databases and datastores.

We strongly recommend that you back up your databases and datastores on a
regular basis. Before upgrading, make sure that you have backups of all your data,
and back up different datastores at the same point in the project (this is sometimes
called a “simultaneous” backup). Doing so will ensure project consistency should
you need to restore your data.

For more information about backing up, contact Rational Technical Support.

� If you use Rational ClearCase or Rational ClearCase LT to store Rational data,
make these preparations:

❑ If you use ClearCase or ClearCase LT with Rational RequisitePro or Rational
Test, make sure that those assets are available through a ClearCase view.

❑ If you established the integration between Rational Suite and ClearCase by
using the Rational Administrator to create a UCM-enabled project, your
RequisitePro and Rational Test assets are already checked out and you don’t
need to take further steps.

❑ If you used another method to integrate Rational Suite and ClearCase, then
check out RequisitePro and Rational Test assets that you store in ClearCase. If
you do not, you will not be able to save changes you make to these assets as
part of the upgrade.

� Ensure that all clients are disconnected from the Rational software you will
upgrade. This means that users should have no connections to a Rational project or
its datastores, and should not use any Rational tools involved in the upgrade until
further notice.
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� Read the Rational Suite Release Notes to learn of any updates to these upgrade
procedures.

The Release Notes are in the top-level directory of the Rational Solutions for
Windows CD, Disk 1 and Disk 2, in the readme.htm file.

Installing New Software

This section describes how to use the Rational Software Setup program to install the
new version of Rational Suite. It also outlines tasks that you need to perform both
before and after you install.

Before You Install

Before you install Rational Suite, perform the following tasks:

1 Under certain circumstances, described later, remove earlier versions of Rational
Suite from your computer.

2 Determine which Rational Suite point products you’re adding to your
environment, and perform pre-installation tasks for them.

The remainder of this section describes these tasks in more detail.

Removing Earlier Versions of Rational Suite

Before you can proceed with the upgrade, remove earlier versions of Rational Suite if
any version of the following software is installed on your computer:

� Beta releases of Rational products

� Rational Suite PerformanceStudio

� Rational LoadTest

� Rational Suite DevelopmentStudio RealTime Edition

� Rational Rose RealTime

� Rational RequisiteWeb (which is installed only on a RequisiteWeb server)
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To remove Rational software:

1 Read about special procedures for removing software in Removing Rational Suite on
page 117. If you are removing RequisiteWeb, see Installing Rational RequisitePro,
and read about “Uninstalling RequisiteWeb” in the chapters about “Installing and
Configuring Rational RequisiteWeb” for Windows or for UNIX.

2 Use the Windows Add/Remove Programs option in the Control Panel to select and
remove Rational Suite or Rational Suite products. The Rational Software Setup
program removes the software from your system.

Performing Tasks Before You Install New Point Products

As part of upgrading to a new version of Rational Suite, it is likely that you will be
adding new point products to your environment. You might add new point products
for some of these reasons:

� The point product is part of Rational Suite in the current version, but it wasn’t part
of Rational Suite when you installed the version you are now using.

� You are adding new editions of Rational Suite to your environment, thereby
introducing new point products.

� You have been adopting Rational Suite incrementally, and you are now adding
new point products to your environment.

� Before upgrading, you removed a point product that you will re-install during the
upgrade.

To prepare for installing new point products:

1 Compare the point products now installed in your environment (click Start, then
click Programs > Rational Suite and scan the menu) to the table on page 21 that
shows point products in each Rational Suite edition.

2 Determine which point products are new.

3 For those point products, follow the instructions in Before You Install – First Time
Installation on page 23.

4 After installing, perform the post-installation steps for those same point products,
as described in After You Install – First Time Installation on page 65. After you install,
we remind you to perform this set of tasks.
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5 Use the following table as a worksheet to track your progress.

Suite Point Product New?
Completed
Pre-Install
Tasks?

Completed
Post-Install
Tasks?

Comments or Notes

Rational ClearCase LT

Rational ClearQuest

Rational ClearQuest
Web

Rational PureCoverage

Rational Purify

Rational Quantify

Rational Process
Workbench

Rational RequisitePro

Rational RequisiteWeb

Rational Robot

Rational Rose

Rational Rose RealTime

Rational SoDA for
Word

Rational TestFactory

Rational TestManager

Rational Unified
Process
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Installing the Latest Version of Rational Suite

Use the Rational Software Setup program to install Rational Suite on all servers and
clients, as described in the chapter Installing Rational Suite on page 59.

Perform the installations in the following order:

1 If you are working with ClearCase LT or ClearCase:

❑ For ClearCase LT, install software on the ClearCase LT server.

❑ For ClearCase, upgrade to the latest version of ClearCase on all VOB servers,
view servers, and the ClearCase Registry Server. If you are installing Rational
Suite 2001A, upgrade to ClearCase Version 4.2 or later.

2 Upgrade software on all other servers, including Web servers, that have Rational
software installed.

3 Upgrade software on all client computers.

Performing Tasks After You Install New Point Products

In Performing Tasks Before You Install New Point Products on page 76, you filled in a
worksheet listing the new point products you are adding to your Rational Suite
environment. For those new point products, perform post-installation steps, as
described in After You Install – First Time Installation on page 65.

Upgrading Installed Point Products: Overview

At this point, you have installed new software on your servers and clients. The
remainder of this chapter describes how to:

� Upgrade ClearQuest databases

� Upgrade a Rational Project and Test Datastore

� Upgrade a RequisitePro database

� Upgrade a Rational Rose RealTime environment (overview)

� Perform last tasks to finish the upgrade process
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Upgrading ClearQuest

This section describes how to upgrade data associated with ClearQuest. Specifically,
this section shows you how to upgrade ClearQuest schemas and databases created
with a previous version of ClearQuest.

This section is written for ClearQuest administrators or people who are comfortable
with administrative concepts related to ClearQuest. Before you start upgrading
ClearQuest, you may want to have the Administering Rational ClearQuest and Installing
Rational ClearQuest manuals available.

Understanding the Upgrade Process for ClearQuest

To upgrade ClearQuest, you perform these general tasks:

1 Start ClearQuest and log in using administrator-level privileges.

2 Establish a new connection to your ClearQuest schema repository, as described in
Reconnecting to a Schema Repository on page 80. Installing ClearQuest resets the
connection to the ClearQuest schema repository.

3 Install the latest packages as required, and test your databases. See Upgrading
ClearQuest Packages on page 80.

4 Apply schema changes to your user databases. See Applying Schema Changes to
User Databases on page 99.

5 Optionally, upgrade ClearQuest feature levels if you want to enable new
ClearQuest features. See Upgrading ClearQuest Feature Levels on page 101.

6 Inform end users that they can now reconnect to the schema repository and
resume work. (We remind you to do this later in this chapter.)
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Reconnecting to a Schema Repository

After you install a new version of ClearQuest, you need to reconnect to your schema
repository as follows:

1 Start the ClearQuest Maintenance Tool: click Start, then click Programs > Rational
Suite > Rational ClearQuest > ClearQuest Maintenance Tool.

2 On the first page, select Connect to Existing schema repository. Click Next.

3 On the next page, enter your database properties, or, in the Profile field, enter the
pathname of a profile file. Click Next.

If you saved a profile file before you installed the latest ClearQuest version, you
can point to it instead of entering database properties by hand. A profile file has an
extension of .ini, for example: dev_profile.ini.

4 On the next page, you have the option of saving the current settings in a profile
file.

5 Click Finish.

Upgrading ClearQuest Packages

Each ClearQuest package implements a ClearQuest integration (for example, with
Rational RequisitePro) or a feature, for example, e-mail rules. If you do not use these
ClearQuest integrations or features, you do not need to upgrade your packages.

If you do use these integrations or features, carefully follow the instructions in this
section to upgrade the associated ClearQuest packages.

Note: This section provides procedures for upgrading packages, but it does not
provide information about the features that each package implements or about the
dependencies among packages. For more detailed information about ClearQuest
packages, see the appendixes in Administering Rational ClearQuest.

To upgrade ClearQuest packages, you perform these high-level steps, as detailed in
the remainder of this section:

1 Determine which packages you need to upgrade.

2 Apply new packages, and in some cases, perform additional steps.

3 Apply schema changes to your user databases. See Applying Schema Changes to
User Databases on page 99.
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Determining Which Packages to Apply

To find out which packages to apply to each user database, run the
package_upgrade_info utility. The utility analyzes the current packages in a user
database and creates a customized checklist of packages you need to apply. To run the
utility, at a command line, change to the ClearQuest installation directory (by default,
c:\Program Files\Rational\ClearQuest) and type the following:

> package_upgrade_info user-id password user-database [dbset]

where:

For example:

> package_upgrade_info admin ““ SAMPL

> package_upgrade_info admin ““ SAMPL 2001A.04.00

These two commands perform the same task: they analyze the SAMPL user database
for the current release, using the admin login.

Note: When you run the utility, you may see an error that contains the text Attempt
to call function RegOpenKeyEx ... System Error: The system can not find

the file specified. If you see this error, it means that you need to connect to your
schema repository. Perform the steps in Reconnecting to a Schema Repository on page 80
and then rerun the utility.

Element Description

package_upgrade_info The utility is installed in the top-level ClearQuest directory.

user-id Any valid ClearQuest user id

password The user’s password (““ signifies no password)

user-database The name of the database to check

dbset The name of the ClearQuest database set containing the user
database you are upgrading. This parameter is optional; omitting
it indicates that you want information on the schema repository
currently connected to ClearQuest.
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Interpreting the Script’s Output

We recommend that you print the script’s output and use it to guide you as you apply
packages. The script displays the following information:

� An overview of the utility

� A list of packages you currently have installed

� Upgrade recommendations, in the form of an ordered list of packages to apply.

For example, as part of the utility’s output, you might see the following excerpt:

--- Checking ClearQuest/TeamTest integration packages
*** Detected an older revision of the Repository package (version

0.2).
*** Please use ClearQuest designer to apply the Repository 2.0 package

*** Detected an older revision of the TeamTest package (version 0.1)
*** Please use ClearQuest designer to apply the TeamTest 1.0 package,

then apply the TeamTest 3.0 Package

--- Checking ClearQuest/RequisitePro integration packages
*** Detected an older revision of the RequisitePro package (version

1.3).
*** Please use ClearQuest Designer to apply the RequisitePro 1.5

Upgrade package

--- Checking ClearQuest/ClearCase UCM integration packages
!!! The AMStateTypes package is not installed.
!!! You will be unable to use the UCM integration between ClearQuest
!!! and ClearCase. If you wish to enable this integration, please use
!!! ClearQuest Designer to apply the AMStateTypes 1.0 Package.

This excerpt tells you to install these packages in this order:

� Repository 2.0 package

� TeamTest 1.0 package

� TeamTest 3.0 package

� RequisitePro 1.5 Upgrade package

� AMStateTypes 1.0 package (if you want to enable the UCM integration; this is a
new package.)
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Applying Packages

For each package to apply, follow these steps:

1 Start the ClearQuest Designer: click Start, then click Programs > Rational Suite >
Rational ClearQuest > Rational ClearQuest Designer. Log into ClearQuest Designer
with Super User or Schema Designer privileges.

2 If the Open Schema dialog box appears, click Cancel.

By default, the Open Schema dialog box appears when you start the ClearQuest
Designer. To change the default, clear the Show this wizard at startup checkbox.

3 From the ClearQuest Designer menu, select Package > Package Wizard.

4 In the Package Wizard, on the Install/Select Package page, select the appropriate
version of the package you are applying. Click Next.

If the package you want is not in the list, click More Packages, and select the
appropriate package. Click OK to return to the Select a Package list. Select the
package and click Next.

5 On the Select a Schema page, select the schema to upgrade with this package. Click
Next.

6 On the Setup Record Types for Packages page:

❑ If you are upgrading a package, leave all record types unselected.

The Package Wizard automatically applies the package to all record types in
your schema that include an earlier version of the package.

❑ If you are installing a new package, for example, AMStateTypes, select the
record types to be enabled by the package.

For the AMStateTypes package, we recommend that you select BaseCMActivity
and Defect, and that you leave EnhancementRequest unselected.

For more information on installing new packages and adding integrations,
refer to Administering Rational ClearQuest.
Upgrading ClearQuest 83



7 If you are applying the AMStateTypes package, perform this additional step:

On the Setup State Types page, associate the AM State Types with the states
defined in your schema. For each defined state (listed in the States column), select
the corresponding AM State Type from the State Type column.

For record type Defect:

8 Click Finish and continue with the remaining steps in this procedure.

State State Type

Submitted

Ready

Active

Complete

Waiting

Ready

Active

Complete

State State Type

Submitted

Assigned

Opened

Resolved

Closed

Duplicate

Postponed

Waiting

Ready

Active

Complete

Complete

Complete

Waiting
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9 From the ClearQuest Designer menu, select File > Checkin to check in the schema
to which you have just applied this package. After verifying your choice, click OK.
Click OK again in the ClearQuest Checkin Confirmation dialog box.

Note: Check in the schema after applying each package. If you apply several
packages before checking in the schema, errors may result.

10 If you are applying certain packages, perform these additional steps:

After Applying the Repository 2.0 Package

Perform the steps in this section after applying the Repository 2.0 package.

When you apply the Repository 1.0 package, many instances of the RepoProject field
associated with some record types (such as Defect and EnhancementRequest) are
renamed to RAProject. The automatic upgrade process cannot rename every instance
of this field, so you need to perform some of this work yourself. We recommend you
perform the steps in this section immediately after applying the Repository 1.0
package, but you can also perform them after applying the Repository 2.0 package.

Note: If you applied the Repository 1.0 package for an earlier version of Rational
Suite, and you are now upgrading to the Repository 2.0 package, you have already
completed the steps in this section. If you have already performed these steps, you do
not need to perform them again.

If you are applying package Perform these steps

Repository 2.0 Perform the steps in After Applying the Repository 2.0 Package
on page 85.

RequisitePro 1.5 Upgrade Perform the steps in After Applying the RequisitePro 1.5 Upgrade
Package on page 93.

Email (latest version) After applying schema changes to the user databases (on
page 99), verify that the e-mail notification for each of your
end users is enabled. For each type of end user (Windows,
UNIX, and Web), see the appropriate section in Installing
Rational ClearQuest (the section titles all start with “Enabling
e-mail notification for...”)

We remind you to perform this task after you apply the
schema change.
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This section describes how to check and upgrade the following:

� Forms with references to RepoProject
� Report formats that include RepoProject fields
� Report format headings
� User-defined hooks
� Web-dependent field lists

Upgrading Form Controls

Upgrade all Form controls that reference RepoProject, replacing those references with
references to RAProject. Perform this upgrade if one of the following conditions
exists:

� You use an out-of-the-box schema such as AnalystStudio, DevelopmentStudio,
TestStudio, or Enterprise.

� You include the RepoProject field in any ClearQuest forms that you have created
in a customized schema, particularly as a result of applying an earlier revision of
the Repository package.

As part of the upgrade process for the Repository package, the RepoProject field was
renamed to RAProject. Consequently, existing form controls that referenced the
RepoProject field now reference a non-existent field and must be repaired. In these
steps, you select properties for that control and change the name of the field
referenced to the RAProject field.

If you do not perform these steps, the field always appears read-only from the client
and the designer schema validation process displays a message saying that there is no
field associated with that control.

The following procedure describes how to upgrade forms for a typical out-of-the-box
example using the Enterprise schema:

1 Display the Open Schema Wizard by performing the following steps:

a If the ClearQuest Designer is not started, start it now: click Start, then click
Programs > Rational Suite > Rational ClearQuest > Rational Designer. Log in with
Super User or Schema Designer privileges.

b If the Open Schema Wizard is not started, start it now: from the ClearQuest
Designer menu, select File > Open Schema.

The Open Schema Wizard appears.

2 On the first page of the Open Schema Wizard, select the schema to modify and
select Checkout a schema to edit. For this example, select the Enterprise schema.
Click Next.
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3 On the next page, enter the reason for the schema modification. For this example,
enter Update Defect forms with new RAProject Fields. Click Finish.

4 In the Designer Workspace, expand the Record Type folder, the Defect folder, and
the Forms folder.

The out-of-the-box schema for the Defects record type contains two forms,
Defect_Base_Submit, and Defect_Base. You need to modify both forms.

5 Double-click the Defect_Base_Submit form to open it. On the form, locate the
RepoProject label. Right-click the drop-down list next to the label and from the
shortcut menu, click Properties.
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6 On the Property Sheet, from the Field Name list, select RAProject. In the Label
field, type RA Project.

7 Repeat these steps for each form in the Defect record type and any record types
and Stateless record types where you include a reference to RepoProject in your
forms. The forms defined for the Defect and EnhancementRequest record types, in
the out-of-the-box Enterprise schema, include references to RepoProject.

Upgrading RepoProject References in Report Formats

If you created Crystal Reports report formats in earlier versions, they may reference
RepoProject. The package upgrade utility cannot redirect these references to the new
field name, RAProject. Editing, creating, or running a report format which contains
these obsolete references results in a ClearQuest error message indicating that the
“fielddef RepoProject does not exist” and that the user should contact Technical
Support.

To assist with this problem, Rational provides a tool to convert the RepoProject field
references to RAProject. You can use this tool any time you use the ClearQuest
Designer to rename a field. The tool is named renrptflds.exe and it is in the ClearQuest
installation directory.

Use it as follows:

1 To view a syntax description for renrptflds.exe, at the command line, type renrptflds
with no parameters.

2 To completely convert all personal report formats, instruct each user who has
personal report formats to run the following command once for each record type
in their schema, for each user database.

renrptflds –us username –p “” –db cqdbname –fmt username
–rec recordtype –fld old_field new_field

where

Option Variable Description

-us username ClearQuest login user name.

-p "" ClearQuest user login password. Empty double quotes mean
that there is no password. If you are converting another user’s
report format, you must supply their password.

-db cqdbname ClearQuest database name.

-fmt username ClearQuest login user name, the same one that you supply with
the -us parameter.
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For example, to convert all RepoProject field references to RAProject for the tkirk
user’s personal report formats based on the “Defect” record type for the SAMPL
database, type the following at the command line:

renrptflds –us tkirk –p “” –db SAMPL –fmt tkirk –rec Defect

–fld RepoProject RAProject

3 To convert public report formats, instruct a user with Super User privileges to type
the following command at the command line:

renrptflds –us admin –p “” –db SAMPL –rec Defect

–fld RepoProject RAProject

In this example, the –fmt option is omitted. As a result, the command will convert
public report formats. In this command, in the –us operand, specify a user who
has Super User authority. The administrator should run this command once for
each user database for each record type containing the RepoProject field.

You have now updated field references in the report format.

-rec recordtype ClearQuest Record Type with the field that has changed.

-fld old_field The name of the referenced field you want to change.

new_field The name of the new reference field.

Option Variable Description
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Upgrading Report Format Headings

Upgrade report format headings when the following conditions are true:

� You customized your schema to refer to RepoProject, and

� You performed these customizations either before applying the Repository 1.0
package, or without applying the Repository 1.0 package.

If these conditions are not true, then you can safely skip the steps in this section.

If your report formats contain headings indicating the names of the fields, you may
wish to change that text to indicate the new field name. The following process
requires that you have Crystal Reports 8.0 installed.

To upgrade report format headings:

1 Start ClearQuest: click Start, then click Programs > Rational Suite > Rational
ClearQuest. Log in using Super User or Public Folder Administrator privileges.

2 Right click on the report to upgrade and click Edit to display the Edit Report
Format dialog box.

3 Click the Author Report button to start Crystal Reports.

4 From the Crystal Reports Designer menu, select Database > Verify Database.

5 Click Yes to proceed with fixing the report.

6 On the Map Fields dialog box, map the report field RepoProject to the active data
field RAProject. For each field, click the field, click Map, then click OK.

7 On the Report Designer Layout page, the field’s name is set to the new value,
RAProject, but text references such as page header information may still contain
the old value. Edit these values appropriately.

8 Save your changes and quit Crystal Reports Designer.

9 On the ClearQuest Edit Report Format dialog box, click OK to save the changes to
the ClearQuest database.

10 Repeat this procedure for each report format (private or public) containing
references to the old field name. If you do not perform this procedure, the report
will run correctly and show correct data, but text references such as column
headings may appear incorrectly.
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Upgrading User-Defined Hooks

Upgrade user-defined hooks when the following conditions are true:

� You customized your schema to refer to RepoProject, and

� You performed these customizations either before applying the Repository 1.0
package, or without applying the Repository 1.0 package.

If these conditions are not true, then you can safely skip the steps in this section.

If you have customized or defined your own hooks, you may have added custom
script code that references the RepoProject fields or the stateless record type
RepoProject by name. Use the hook editor to modify these hooks so that they
reference RAProject instead. Any hook code owned by an out-of-the-box ClearQuest
package will automatically be modified to use RAProject.

To find all hooks that define references to the RepoProject field:

1 Display the Open Schema Wizard by performing the following steps:

a If the ClearQuest Designer is not started, start it now: click Start, then click
Programs > Rational Suite > Rational ClearQuest > Rational Designer. Log in with
Super User or Schema Designer privileges.

b If the Open Schema Wizard is not started, start it now: from the ClearQuest
Designer menu, select File > Open Schema.

The Open Schema Wizard appears.

2 Select one of your schemas and click Next.

3 On the next page, enter the reason for this schema modification. For this example,
enter Update Defect hooks with new RAProject Fields. Click Finish.

4 From the ClearQuest Designer menu, select Edit > Find in Hooks.

5 On the Find in Hooks dialog box, in the Find What field, type RepoProject and click
Find. The lower window of the ClearQuest Designer lists all instances of this field
name.

6 For each script listed:

a Double-click the script to display the script editor. (The editor opens at the line
containing RepoProject.)

b Modify the script.

c Keep a list of each script you modify. (You need this list to complete Step 7.)

7 Select Hooks > Compile to check the syntax of each script you modified.
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8 Check in your schema changes: from the ClearQuest Designer menu, select File >
Checkin. After verifying your choice, click OK. Click OK again in the ClearQuest
Checkin Confirmation dialog box.

9 Repeat this process for each of your schemas.

Upgrading Web-Dependent Field Lists

If you have identified the RepoProject field as a web-dependent field for any control
in a form, remove the reference to RepoProject in that control and replace it with
RAProject. In this section, we call such a control a RepoProject-dependent control.

To change RepoProject-dependent controls:

1 Display the Open Schema Wizard by performing the following steps:

a If the ClearQuest Designer is not started, start it now: click Start, then click
Programs > Rational Suite > Rational ClearQuest > Rational Designer. Log in with
Super User or Schema Designer privileges.

b If the Open Schema Wizard is not started, start it now: from the ClearQuest
Designer menu, select File > Open Schema.

The Open Schema Wizard appears.

2 On the first page of the Open Schema Wizard, select the schema in which you have
defined a Value_Changed hook related to RepoProject.

3 Select Checkout a schema to edit. Click Next.

4 On the next page, enter the reason for this schema modification. For this example,
enter Update Web Dependent fields to reference new RAProject Fields. Click Finish.

5 Expand the Record Type folder, expand the appropriate record type, expand the
Forms folder, and locate all the forms that display the RAProject field.

6 Open the form that includes the RepoProject-dependent control. Right-click the
RepoProject-dependent control, select Properties, and click the Web Dependencies
tab.

7 In the Selected List, replace the RepoProject entry with RAProject.

8 Check in your schema changes: from the ClearQuest Designer menu, select File >
Checkin. After verifying your choice, click OK. Click OK again in the ClearQuest
Checkin Confirmation dialog box.
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After Applying the RequisitePro 1.5 Upgrade Package

Perform the steps in this section after applying the RequisitePro 1.5 Upgrade package.
At a high level, the steps are:

1 Establish associations between ClearQuest and RequisitePro to enable the
integration between the two products. To establish these associations, you edit a
utility, ASCQISetup.bat.

2 Add a back-reference field to certain fields in ClearQuest.

3 Later, you run the ASCQISetup.bat utility. (We remind you at the appropriate time.)

Establishing Associations Between ClearQuest and RequisitePro

To enable the integration of ClearQuest and RequisitePro, you need to create an
association between ClearQuest record types and RequisitePro requirement types.
You create this mapping by editing and running a batch file. Because the batch file has
changed, you need to perform this work even if you performed it in for an earlier
version.

The following sections describe the required steps:

� Collecting data related to your ClearQuest database and RequisitePro project
environment.

� Editing the ASCQISetup.bat batch file.

� Later in this chapter, we instruct you to run the edited ASCQISetup.bat batch file.

Collecting Setup Information

To enable the integration in your specific environment, you must edit the ASCQISetup
batch file. This file contains the command arguments shown in Table 13. Use this table
to record the values of each variable for your project. You will use this information to
edit the batch file.
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Note: If your installation spans multiple computers, use Universal Naming
Conventions (UNC) paths, as noted in Table 13.

Table 13 Variables Describing Your Environment

Batch Command Description Must Edit Your Values

set CQDatabaseName
=

The name of the
ClearQuest User
database

You must edit this
entry.

set H = The hard drive letter
where RequisitePro
is installed, followed
by a colon (for
example C:). This
refers to the
Administrator’s
installation, not the
client installation.

The default value is
“C”. Edit this entry
only if you installed
RequisitePro on a
drive other than the
“C” drive.

set U = The Superuser logon
name for the
ClearQuest
database, the
RequisitePro project,
and the Rational
Project

The default value for
the Superuser logon
is “admin”. If you
are using a logon for
RequisitePro,
ClearQuest, or the
Rational Project
other than “admin”,
edit this field. (The
Super user logon
refers specifically to
ClearQuest user
privileges.)

set P = The path to the
administrator’s local
Rational installation
directory

You must edit this
field to display your
administrator’s
installation location.

set RP = The name of the
RequisitePro project
as displayed in the
RequisitePro Project >
Open dialog box.

You must edit this
field to display the
name of your
RequisitePro project
that you will
integrate.
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Editing the ASCQISetup.bat File

Now use the information in the preceding table to modify the ASCQISetup.bat file for
your specific environment. The file is in the directory
Install\Program Files\Rational\Common. The ASCQISetup.bat file is designed to be run only
by the administrator and all settings in this file should reflect those of the
administrator’s installation. After the file runs, it does not need to run again unless
one of the above variables changes. Edit and run this file once for each RequisitePro
and ClearQuest project that you want to integrate.

Begin by saving a copy of the ASCQISetup.bat file with a name that corresponds to
your Rational project (you use the Rational Administrator to create a Rational project).
For example, you might create a copy named ASCQI_RA_project_name.bat. Edit this
copy to include the data specific to your ClearQuest database and RequisitePro
project environment as follows:

1 Use a text editor such as Notepad to open the file.

2 Locate each set command and provide the value containing your project-specific
information you supplied in Table 13.

set RQS = The full directory
path to the
RequisitePro *.rqs
file

You must edit this
field to indicate the
correct path of the
RequisitePro project.
Use the path defined
in your RequisitePro
.rqs file. If your
installation spans
multiple computers,
use a UNC path.

set Help= The full path to the
ClearQuest/
RequisitePro
Integration help file
(Program Files\Ratio
nal\ RequisitePro\
Help\CQI.hlp).

You must edit this
field if the CQI.hlp
file is in a location
other than the
default location
listed in the
ASCQISetup.bat file.
If your installation
spans multiple
computers, use a
UNC path.

Table 13 Variables Describing Your Environment (continued)

Batch Command Description Must Edit Your Values
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The following example of a modified ASCQISetup.bat file was edited to work with the
integration for the Rational Suite Tutorial data, which is used throughout the
document, Getting Started with Rational Suite AnalystStudio. This sample batch file
reflects a local installation of RequisitePro and an unmodified help file. Remember to
use UNC paths when necessary to reflect your installation environment.

Note: Fields that you must edit are in bold and are surrounded by angle brackets
(<< >>). When editing to reflect your project specifications, replace the entire
command, including the angle brackets, with information about your administrator’s
project installation.

Note: The REM command precedes a comment.

REM Before you launch this batch file, please update the following
information:

REM **** INFORMATION TO UPDATE ****

REM Update the name of the ClearQuest database.
set CQDatabaseName=<<CLSIC>>

REM Update the hard drive letter where your local Rational products are
installed.
set H=<<C:>>

REM Update the SuperUser login name for ClearQuest database and
RequisitePro project.
set U=<<admin>>

REM Update the path to your local Rational installation directory.
set P=<<\\Server_Name\Program Files\Rational\>>

REM Update the name of your RequisitePro project.
set RP=<<Order Processing and Fulfillment System>>

REM Update the full name to your RequisitePro .rqs file.
REM Use a UNC path for a project on a nonlocal computer.
set RQS=<<\\<Server_Name>\Program Files\Rational\Classics Demo\
ClassicsRepo\Project\ClassicsPOS\Requisite\requisite.rqs>>

REM Update the path to the cqi.hlp file.
REM Use a UNC path for a project on a nonlocal computer.
set Help=<<\\<Server_Name>\Program Files\Rational\RequisitePro
\help\cqi.hlp>>
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REM **** BEGINNING OF THE SCRIPT ****

%H%
cd %P%\common

REM Create the association between the 'Defect' ClearQuest record type
and the RequisitePro attribute 'Defect' of the Feature requirement
type.

ASCQISetup.exe -c %U% %CQDatabaseName% Defect Requirements_List
Defects_list RAProject Modify "Associate Defects" "%Help%" 1 "%RP%"
"%RQS%" FEAT Defect 2

pause

REM Create the association between the 'EnhancementRequest' ClearQuest
record type and the attribute 'EnhancementRequest' of the Feature
requirement type.

ASCQISetup.exe -c %U% %CQDatabaseName% EnhancementRequest
Requirements_List EnhancementRequests_list RAProject Modify "Associate
Enhancement Requests" "%Help%" 1 "%RP%" "%RQS%" FEAT
EnhancementRequest 2

pause

Notes:

� For more information about customizing the integration or about the
ASCQISetup.exe command arguments, see the chapter about Configuring the
Integration for ClearQuest and RequisitePro in the manual, Configuring Rational Suite.

� If you have a RequisitePro project that does not have security enabled, your
RequisitePro default project logon user name must be set to the SuperUser login
name specified in the ASCQISetup.bat file. This setting is available through the
RequisitePro Tools > Options menu command.

Adding a Back-Reference Field

For every record type that you have applied when you originally installed the
RequisitePro package, you need to locate the Requirements_List field and add a
back-reference field to it.
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Naming the Back-Reference Field

Name this back-reference field consistently with the names in the file:
Install\Program Files\Rational\Common\ASCQISetup.bat

For example, the ASCQISetup.bat file might contain lines similar to the following:

REM Create the association between the 'Defect' ClearQuest record type and
REM the RequisitePro attribute 'Defect' of the Feature requirement type

ASCQISetup.exe -c %U% %CQDatabaseName% Defect Requirements_List Defects_list
RAProject Modify "Associate Defects" "%Help%" 1 "%RP%" "%RQS%" FEAT Defect 2

The line starting with ASCQISetup.exe includes Defect, Requirements_List,
and Defects_list. These are defined as follows:

Upgrading the Back-Reference Field

The ClearQuest/RequisitePro integration requires a back-reference field on the
Requirements_List field for each of the record types you selected when you applied the
RequisitePro package, such as Defect and EnhancementRequest.

To add a back-reference field to your schema, do the following:

1 Display the Open Schema Wizard by performing the following steps:

a If the ClearQuest Designer is not started, start it now: click Start, then click
Programs > Rational Suite > Rational ClearQuest > Rational Designer. Log in with
Super User or Schema Designer privileges.

b If the Open Schema Wizard is not started, start it now: from the ClearQuest
Designer menu, select File > Open Schema.

The Open Schema Wizard appears.

2 On the first page of the Open Schema Wizard, select the schema in which you have
applied the RequisitePro 1.5 package.

3 Select Checkout a schema to edit. Click Next.

4 On the next page, enter the reason for this schema modification. For this example,
enter Add back-reference field to reference new Requirements_List fields. Click Finish.

Defect = ClearQuest record type

Requirements_List = The RequisitePro field added to the Defect record type

Defects_list = The name of the back-reference field associated with the
Requirements_List field of a Defect record.
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5 In the ClearQuest Workspace, expand the Record Types folder for the record type
with RequisitePro integration, and expand the Fields grid. The list of fields
appears in the right panel.

6 Right-click the Requirements_List field name and select Field Properties. The
properties dialog box appears. This field is enabled only if you need to set up the
back-reference field. If this work has already been performed, the field is disabled.

7 In the back-reference field, enter the name you identified in “Naming the
Back-Reference Field” on page 98. For some schemas, this field may already
contain the correct value. If the field contains a value that is incorrect, change it.

8 Close the properties dialog box.

9 Repeat from Step 5 for each of the record types you selected when you applied the
RequisitePro package. Each record should have an entry in the ASCQISetup.bat
file. See “Naming the Back-Reference Field” on page 98.

10 From the ClearQuest Designer menu, select File > Checkin to check these changes
into your schema. After verifying your choice, click OK. Click OK again in the
ClearQuest Checkin Confirmation dialog box.

Applying Schema Changes to User Databases

This section describes how to apply schema changes to your user databases. Perform
these steps now. In general, you should always perform the steps in this section after
making changes in the ClearQuest Designer, such as applying packages. The effect of
performing these steps is to push changes in your schema to the user databases.

Applying schema changes takes just a few minutes for each user database.

Warning: After you apply schema changes, you cannot reverse or undo the action.
Always back up your databases before starting this procedure.
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To apply schema changes:

1 Start the ClearQuest Designer: click Start, then click Programs > Rational Suite >
Rational ClearQuest > Rational ClearQuest Designer. Log in with Super User or
Designer privileges.

2 If the Open Schema Wizard appears, click Cancel.

3 From the Designer menu, select Database > Upgrade Database.
A message warns you that this action cannot be reversed, recommends that you
back up your databases before proceeding, and asks you if you want to continue. If
you have backed up your databases, click Yes.

4 Select the user database from the list in the Upgrade Database Wizard. Click Next.

5 On the next page, select the schema master database version from the list.

If your most recent version does not appear in this list, it probably is not checked
in. In that case, click Cancel to quit this wizard. On the Designer menu, click File >
Open Schema, then check in the schema. You can now restart this process.

6 Click Finish. When the upgrade completes, a message appears saying that the
database has been upgraded successfully.

After Applying Schema Changes

After applying schema changes, perform these steps:

1 Rerun the script you ran in Determining Which Packages to Apply on page 81 to
verify that you have applied packages correctly.

2 Reminder: If you applied the Email package, verify that e-mail notification is
enabled for each end user. See Step 10 on page 85.

3 If you are using the integration between ClearQuest and RequisitePro, run the
ASCQISetup.bat utility that you edited earlier. Running this utility creates the
associations between ClearQuest record types and RequisitePro requirements:

a At a command line, change to the directory Install\Program Files\Rational\Common
and type ASCQISetup.

As the batch file runs, it pauses every time it creates an association and prompts
you to Press any key to continue.

b Press ENTER until the batch file ends.

4 Update your maintenance plans to include new user databases and schema
repositories, and to omit the old ones.

You have now applied schema changes to your ClearQuest user database.
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Upgrading ClearQuest Feature Levels

This section describes how to upgrade ClearQuest feature levels. These steps are
optional. Perform these steps if you want to enable new features in the current version
of ClearQuest. In Version 2001A, these new features are Rational ClearQuest MultiSite
Technology Preview and the improved security model. If you do not want to enable
these features, you do not have to upgrade feature levels.

Upgrading ClearQuest feature levels can take several hours. The upgrade changes the
schema repository and all its associated user databases. Typically, new tables are
added to all databases, and new columns may be added to existing tables.

Overview of Upgrade Process

As part of upgrading ClearQuest feature levels, we strongly recommend that you
perform the upgrade first on a test system, and then perform it again on production
databases. At a high-level, the process is as follows:

1 Verify your environment.

2 Create a test bed based on production databases.

3 Upgrade the test bed and validate that the upgrade was successful.

4 Create new databases for the production system.

5 Upgrade the production databases and validate that the upgrade was successful.
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The following illustration shows the general process for creating the test bed,
upgrading it, and validating the upgrade. The process for upgrading production
databases is similar.

Verifying Your Environment

Before you start the upgrade, be aware that the upgrade could fail under certain
conditions. The following table describes these conditions and how to resolve them.

Condition Solution

You currently have a ClearQuest schema
checked out.

Check in your ClearQuest schema.

Your ClearQuest database is locked. Unlock your database. For more information,
read “Unlocking Databases” in the chapter,
“Upgrading Rational ClearQuest” in
Installing Rational ClearQuest.

You have customized your schema to include
Record Types or fields that have a ratl_ prefix.

Contact Rational Technical Support. They will
explain how to correct this condition.
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Creating a Test Bed

The following steps describe how to create a test bed based on your production
databases:

1 Back up your data.

Back up your schema repository and user databases. Upgrading ClearQuest
feature levels changes the underlying structure of your data and can change your
schemas. We strongly recommend you create a backup so you can revert to it if
necessary.

2 Create new, empty vendor databases for each schema repository and user
database, as described in “Configuring Vendor Databases” in Installing Rational
ClearQuest. Create the new databases in a new test directory or on a test server. In
this section, we refer to these new databases as the test bed.

Note: Create empty databases only. Do not use your vendor database tools to
move or copy the data. ClearQuest updates the data structure and moves it into
the new databases as part of the upgrade process.

3 Notify users to log off from ClearQuest, and shut down your web server. Instruct
users not to access ClearQuest during the upgrade process. Ensure that all users
have disconnected from ClearQuest by using one of these techniques:

❑ Some high-end databases give the administrator a tool for logging users off
from the database. Check your vendor database to see if it has such a tool.

❑ Check the Task Manager Process List of each client and server computer. If one
of these processes is running, use the Task Manager to end the process:

clearquest.exe, cqdesign.exe, or any cqintsvr*.exe process

4 Copy your existing production schema repository and user databases to the test
bed databases. Use the ClearQuest installutil utility with the options,
convertschemarepo and convertuserdb. For more information about this
utility, read about “Creating Database Copies” in the chapter, “Upgrading Rational
ClearQuest” in Installing Rational ClearQuest.

Using the convert options with the installutil utility causes ClearQuest to
lock the original production databases. If you need to unlock them, read about
“Unlocking Databases” in the chapter, “Upgrading Rational ClearQuest” in
Installing Rational ClearQuest.

5 For each database in the test bed, create another new empty vendor database.
These will be the databases that you upgrade to. In this section, we refer to these
new databases as the test upgrade set.
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Upgrading the Test Bed

In this section, you upgrade the test bed and verify that the upgrade was successful.
Upgrade the test bed as follows:

1 Start the ClearQuest Maintenance Tool: click Start, then click Programs > Rational
Suite > Rational ClearQuest > Rational ClearQuest Maintenance Tool.

2 Select Upgrade schema repository and/or user database(s) and click Next.

3 Specify the test schema repository to upgrade. Click Next.

4 To upgrade user databases associated with this schema repository, select the
Upgrade user databases option.

5 Enter the ClearQuest login name and password for a ClearQuest user account with
Super User privileges, then click Next.

6 From the list of user databases associated with the schema repository, select one or
more user databases to upgrade.

7 Enter the schema repository to upgrade to (the new, empty database you created in
the test upgrade set), then click Next.

8 For each user database you selected in Step 6, enter the user database to upgrade
to (the new, empty databases you created in the test upgrade set). Click Next.
Repeat until you have associated all the user databases you selected. Click Finish.

ClearQuest upgrades your schema repository and user databases, and notifies you
when the process is complete.

9 Verify that the upgrade process completed successfully:

a When ClearQuest notifies you that the upgrade process is complete, carefully
read the message to ensure that the process completed successfully.

b Reconnect to the schema repository, following the instructions in Reconnecting
to a Schema Repository on page 80.

c Test the application. Enter a few test records of each record type and move
them though the entire state model to be sure the upgrade is working correctly.

Creating Production Databases

After you verify that the test upgrade is successful, proceed to upgrade your
production databases. The steps for upgrading production databases are nearly
identical to those for upgrading the test databases.
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The following steps describe how to upgrade production databases:

1 Create new, empty vendor databases for each schema repository and user
database, as described in “Configuring Vendor Databases” in Installing Rational
ClearQuest. Create the new databases on the production server. In this section, we
refer to these new databases as the production upgrade set.

Note: Create empty databases only. Do not use your vendor database tools to
move or copy the data. ClearQuest updates the data structure and moves it into
the new databases as part of the upgrade process.

2 Notify users to log off from ClearQuest, if any are logged in, and shut down your
web server.

Upgrading the Production Databases

In this section, you upgrade from your original production databases to the
production upgrade set as follows:

1 Start the ClearQuest Maintenance Tool: click Start, then click Programs > Rational
Suite > Rational ClearQuest > Rational ClearQuest Maintenance Tool.

2 Select Upgrade schema repository and/or user database(s) and click Next.

3 Specify the original production schema repository to upgrade. Click Next.

4 To upgrade user databases associated with this schema repository, select the
Upgrade user databases option.

5 Enter the ClearQuest login name and password for a ClearQuest user account with
Super User privileges, then click Next.

6 From the list of user databases associated with the schema repository, select one or
more user databases to upgrade.

7 Enter the schema repository to upgrade to (the new, empty database you created in
the production upgrade set), then click Next.

8 For each user database you selected in Step 6, enter the user database to upgrade
to (the new, empty databases you created in the production upgrade set). Click
Next. Repeat until you have associated all the user databases you selected. Click
Finish.

ClearQuest upgrades your schema repository and user databases, and notifies you
when the process is complete.
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9 Verify that the upgrade process completed successfully:

a When ClearQuest notifies you that the upgrade process is complete, carefully
read the message to ensure that the process completed successfully.

b Reconnect to the schema repository, following the instructions in Reconnecting
to a Schema Repository on page 80.

c Test the application. Enter a few test records of each record type and move
them though the entire state model to be sure the upgrade is working correctly.

10 After verifying that the upgrade completed successfully:

a To prevent users from accidentally using the original production databases,
either keep them locked or remove them.

b Optionally, discard the test bed and test upgrade set.

Upgrading Rational Test and Your Rational Project

This section describes actions to take if:

� You want to verify that ClearQuest packages are correctly configured for a
Rational Project.

� You are upgrading from Rational Suite Version 2001.03.00.

� You are upgrading from Rational Suite Version 2000.02.10.

Verifying ClearQuest Packages for a Rational Project

If you are working with a Rational project, or if you have upgraded from a Rational
repository to a Rational project, you can verify that the ClearQuest packages for your
Rational project are correctly configured and upgraded:

1 Start the Rational Administrator: click Start, then click Programs > Rational Suite >
Rational Administrator.

2 In the left pane of the Administrator, select a project, right-click it, and select
Connect.

3 Select the same project, right-click it, and select Configure to display the Configure
Project dialog box.

4 Click Close to initiate the program that checks your project.

If the correct packages are applied, you do not see a message. However, if there are
packages to apply or upgrade, a message appears directing you to this chapter.
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Upgrading from Version 2001.03.00

If you are upgrading from Rational Suite Version 2001.03.00, your Rational project,
including your Rational Test datastore, is already upgraded, so you do not need to
perform further upgrading tasks with respect to Rational Test. You may now proceed
to Upgrading RequisitePro on page 111.

Upgrading from Version 2000.02.10

If you are upgrading from Rational Suite Version 2000.02.10, follow the instructions in
this section.

In Version 2000.02.10 and earlier, Rational assets were stored in a Rational repository.
Starting with Version 2001.03.00, Rational assets were stored in a Rational project.
Because you are upgrading from Version 2000.02.10, you need to convert your
Rational repository to a Rational project. To perform the conversion, you run a wizard
which does the following:

� Checks whether ClearQuest packages need to be upgraded and provides further
instructions in this area.

� Runs the RequisitePro project upgrade tool.

� Converts each project in a repository into a new Rational Administrator project. It
also maintains any links that you created in a repository project to a ClearQuest
database, RequisitePro project, or Rose model.

� Copies the repository’s global assets, such as users, groups, and computers, into
each new Rational project.

Before You Convert

Before converting, perform these steps:

� Make sure all users have disconnected from the Rational project and are not using
any of the tools in the project.

� Back up your current repository. You will not be able to use it as a repository after
you convert it to a project.

� Be aware that you must have administrator permission to convert the repository.

� Decide whether you want to rename the repository’s projects, and if yes, do so
before you start the conversion. During the conversion, the name of the Rational
repository is removed, while each project inside that repository retains its name. To
make it easier for users to understand the role of each project, you may want to
rename the projects.
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Performing the Conversion

To convert a Rational repository to a Rational project, perform the following steps:

1 Start the Rational Administrator: click Start, then click Programs > Rational Suite >
Rational Administrator.

2 From the Administrator menu, select File > Convert Rational Repository into
Rational Projects.

3 On the Repository Conversion - Login page, enter the path of the repository you
want to convert, as well as the user ID and the password. Click Next.

4 On the Destination page, enter the path where the new Rational project will reside.
Click Next.

This directory becomes the root for all new projects. One new Rational project is
created under this directory for each 2000.02.10 project in the source repository. All
repository global assets, such as users, groups, and computers, are copied into
each new Rational project.

5 On the Options page, select one of the following options and click Next:

❑ Automatically create a Test Case for each RequisitePro requirement that defines
test criteria and is associated with a test script.

If you select this option, then one test case is created for each requirement even
if multiple scripts are linked to the requirement.

❑ Automatically create a Test Case for each Test Script associated with a
RequisitePro requirement that describes a feature of the application under test.
This option is recommended if multiple Test Scripts are associated with the
same RequisitePro requirement.

If you select this option, then one test case is created for each script linked to the
requirement. If there are multiple scripts, then multiple test cases are created.

For more information about test cases, see the Using Rational TestManager manual
or the Rational TestManager Help.

6 On the Summary page, review your settings and click Finish.

The output is captured in the RepositoryConvert.txt log file in your temp directory.
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Rational Test Asset Conversion Information

In Version 2000.02.10, test assets were stored in a repository project. Starting with
Version 2001.03.00, they are stored in a Test Datastore. Each Test Datastore is
associated with a Rational project. Any 2000.02.10 test assets that were global to the
repository are copied into each Test Datastore created for a 2000.02.10 repository
project. Thus, test assets within a Test Datastore are not shared with any other Test
Datastore.

Within a Test Datastore, the test assets persist as a collection of files. The properties
and relationships of each test asset are stored within an XML file. These files are
organized within the Test Datastore directory structure. Each Test Datastore also uses
a Microsoft Access database to cache some of the information in the XML files for use
by reports and queries.

Note: Users and Groups are stored in a separate datastore called a
UserGroupTestDatastore. This datastore is a directory containing the Test Datastore’s
users and groups. It is created in a subdirectory of the Rational Administrator project.

Test cases are a new asset type. Test cases define the individual tests that are executed
in order to validate test inputs such as RequisitePro requirements. In a 2000.02.10
repository project, scripts served this purpose and implemented the test, itself. In the
new Rational Test, scripts are only used as implementations and do not play any role
in test coverage. To facilitate this new model, the conversion program creates test
cases based on the script/requirement relationships that exist in the 2000.02.10
repository project.

The following table lists the data that is converted from a Version 2000.02.10
repository to a Version 2001A.04.00 project:

Types of 2000.02.10 Rational Test Assets Converted?

Scripts Yes (including VPs and Low-Level Scripts)

Schedules Yes (now called Suites)

Sessions Yes

Users Yes

Groups Yes

Computers Yes

Datapools Yes

Data Types Yes
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The following table lists the new test asset types:

Performance Reports Yes

Listing Reports No

Logs No

Builds Yes

Test Documents No

Coverage Reports No

Queries No

Log Filters No

New Test Asset Types Description

Computer List A collection of Computer assets that can be
referenced as the execution target for Suites,
Test Cases, and Scripts.

Test Plan A collection of Test Cases which define
“what” needs to be tested for a particular
feature or set of features.

Test Case A specific “test” that needs to be planned,
designed, and executed in order to validate
some aspect of the System Under Test (SUT).

Configured Test Case A specific “test” that needs to be run under a
specific configuration (for example, Operating
System).

Listing Report (based on Crystal Reports) A type of report that displays information
about the test assets that are stored in the Test
Datastore.

Test Case Analysis Report A type of report that displays information
about Test Cases and Test Case Results stored
in the Test Datastore.

Iteration A specific period of time during a project,
which is typically associated with some exit
criteria and milestones.

Types of 2000.02.10 Rational Test Assets Converted?
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Upgrading RequisitePro

When you upgrade RequisitePro, you perform these tasks:

� Upgrade a RequisitePro project

� Upgrade RequisitePro for use with the Rational Synchronizer

Upgrading a RequisitePro Project

To upgrade a RequisitePro project, you use the RequisitePro Database Upgrade
Wizard. You need to upgrade a RequisitePro project if:

� It is in a Rational project but did not get upgraded

If you are upgrading from Version 2001.03.00, then you need to upgrade your
RequisitePro project as described in this section. If you upgraded a Rational
repository to a Rational project (in Upgrading Rational Test and Your Rational Project
on page 106), your RequisitePro project was upgraded automatically and you do
not need to perform the steps in this section.

� It is not in a Rational project

Test Input Identifies some aspect of the SUT that needs to
be verified by a Test Case.

Test Input Type Types of Test Inputs include RequisitePro
requirements and Rose Model elements.
Non-Rational inputs, such as .csv or Microsoft
Excel files, are configured as part of the
TestManager extensible Test Input
mechanism.

Test Script Type Types of scripts, such as GUI, VU, Java, and
VB.

Configuration Attribute A specific aspect of a configuration, for
example, OS, OS Version, or memory.

Configuration A collection of Configuration Attributes
which together describe some environment
under which some set of Test Cases need to
execute and pass.

New Test Asset Types Description
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Before You Upgrade

Before you upgrade a RequisitePro project, perform the following tasks:

� This upgrade modifies tables and properties of the database. For these reasons,
you cannot revert to the original state before the upgrade. We recommend backing
up the database before starting the upgrade.

� This process upgrades all RequisitePro projects in an enterprise database. Make
sure all RequisitePro users have closed all projects in the database before
continuing with the upgrade.

� In order to perform the database upgrade on projects, you must have RequisitePro
administrator permissions.

Starting the Wizard

You start the wizard differently depending on the following:

� The RequisitePro project is in a Rational project and you are upgrading from
Version 2001.03.00. Start the Database Upgrade Wizard as follows:

a Start the Rational Administrator: click Start, then click Programs > Rational
Suite > Rational Administrator.

b If you are not already connected to the Rational project associated with the
RequisitePro project that needs to be upgraded, connect now: from the
Administrator menu, select File > Connect, then select the Rational project to
which you want to connect.

c From the Administrator menu, select File > Upgrade RequisitePro Project.

d Select the RequisitePro project you want to upgrade and click OK.

The Database Upgrade Wizard appears.

� The RequisitePro project is not in a Rational project.

If you have administrative privileges and you open a RequisitePro project that
needs to be upgraded to the current version of RequisitePro, the Database
Upgrade Wizard appears.
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Performing the Upgrade

While you work with the Database Upgrade Wizard, keep these points in mind:

� The Database Upgrade Wizard guides RequisitePro project administrators through
the process of upgrading existing database structure and project data to the
current RequisitePro release.

� If security is enabled for the project, you must type your Rational RequisitePro
User ID and Password.

� If there are multiple projects in an enterprise database, you must type the User ID
and Password used to create the enterprise database.

� After you’ve upgraded the project database, other users will not be able to access
the affected projects until they upgrade to the current version of RequisitePro.

� If the project you are upgrading contains cross-project traceability links, you must
upgrade the external projects as well. If the external projects have security enabled,
you are prompted to log in to those projects while the Database Upgrade Wizard is
running. You can also check for references to external projects in any RequisitePro
project by clicking Project > External Projects.

Upgrading RequisitePro for Use with the Rational Synchronizer

Perform the steps in this section if you use the Rational Synchronizer to synchronize
artifacts within a project.

Converting SynchLink Attributes

The Rational Synchronizer tracks links to and from requirements by storing data in a
requirement attribute called SynchronizerSynchLink. This attribute must be present
in any requirement type used as a source or a target of a synchronization rule.

After you convert the RequisitePro database, rename the SynchLink attribute to
SynchronizerSynchLink as follows:

1 Start RequisitePro: click Start, then click Programs > Rational Suite > Rational
RequisitePro.

2 Open your RequisitePro project: from the RequisitePro menu, select Project >
Open, select the project to open, and click OK.

3 From the RequisitePro menu, select Project > Properties.
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4 On the Attributes tab, select a Requirement Type that you want to synchronize,
then:

To edit a SynchLink attribute:

a From the Labels for Attributes list, select SynchLink and click Edit.

b On the Edit Attribute dialog box, in the Label field, type SynchronizerSynchLink
and click OK.

To add a SynchronizerSynchLink attribute:

a Click Add to insert the SynchronizerSynchLink.

b On the Add Attribute dialog box, in the Label field, type
SynchronizerSynchLink, from the Type list, and select Text. Click OK.

5 Click OK to quit the Project Properties dialog box.

The data within the SynchLink attribute is automatically converted the first time you
attempt a synchronization with the newly installed software.

Upgrading Rational Rose RealTime

If you are upgrading from Rational Suite 2001.03.00 and your environment includes
Rational Rose RealTime, your Rose RealTime models will work with the current
version of Rational Suite.

If you are upgrading from Rational Suite 2000.02.10 and your environment includes
Rational Rose RealTime, read about “Migration from Rose RealTime 6.x” in the
“Migration” chapter of Installation Guide, Rational Rose RealTime to learn about:

� Handling file format changes
� Working with source control
� Migrating when using the C Language
� Migrating when using the C++ Language
� Other changes to the Rose RealTime environment

Note: Online versions of the manuals for Rose RealTime are in the directory,
%ROSERT_HOME%\help.The Rational Rose RealTime manuals are not included on the
Rational Solutions for Windows Documentation CD.
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Finishing the Upgrade Process

As a last step, inform users of the new information to use to reconnect to ClearQuest.
When users start ClearQuest, the ClearQuest Maintenance Tool will prompt them to
supply this information.

You have now finished with the upgrade process. Your team can now resume its
work.
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8Removing Rational Suite
This chapter describes the requirements and procedure for removing Rational Suite or
Rational Suite products from your system.

Before You Remove Rational Suite

This section provides general requirements for removing Rational Suite or Rational
Suite products from your system. It also describes which components the Rational
Software Setup program does or does not remove from your system.

� If you plan to move the application to another system, first return the license key
file to your Rational Software account. To return a license key, use Rational
AccountLink (www.rational.com/accountlink), the online license management tool.
For more information about moving licenses or returning licenses, see the
Administering Licenses for Rational Software manual.

� Removing an earlier version of Rational Suite does not delete your license key file,
project databases, and other files that you created while using Rational Suite. If
you plan to install an upgrade of Rational Suite to a different drive or use a new
installation path, back up these files and manually remove them. If you do not
remove them, the Rational Software Setup program may find these files and install
the appplication in the old location instead of the new location.

� To remove Rational Software products from a Windows NT or 2000 system, you
must have Windows NT administrator privileges on the local system.

� Make sure that no one is using the application or any associated files. You cannot
remove files that are in use.

� SiteCheck is automatically installed with many Rational Suite products. The
Rational Software Setup program does not remove this product from the system.
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Removing Rational Suite

This section provides procedures for removing Rational Suite or Rational Suite
products from your system.

Note: If you are removing ClearCase LT from your system, see Removing ClearCase LT
Data from a ClearCase LT Server before you use Add/Remove Programs.

Use the Windows Add/Remove Programs control panel to select and remove Rational
Suite or Rational Suite products. The Rational Software Setup program removes the
software from your system.

Additional Removal Instructions

This section explains additional product-specific procedures for removing Rational
Suite.

Removing ClearCase LT Data from a ClearCase LT Server

You can remove ClearCase LT and all ClearCase LT data (VOBs, views, and storage
locations), or you can simply remove ClearCase LT.

Warning: ClearCase LT data may be valuable. Do not remove it unless you know that
the data is not important.

You do not need to remove ClearCase LT data from a ClearCase LT server unless you
intend to reinstall ClearCase LT server on the system and rerun the Server Setup
Wizard to create a new set of VOBs. If you want to rerun the Server Setup, delete the
following registry key:

HKLM\Software\Atria\ClearCase\CurrentVersion\ServerSetupComplete

and remove the ClearCase LT data. If you do not perform these tasks, you may
encounter errors when the Server Setup starts.

To remove ClearCase LT data from the ClearCase LT server:

1 Use the ClearCase Administration Console or the cleartool lsvob command to
locate all the VOBs on the ClearCase LT server. Then use the ClearCase
Administration Console or the cleartool rmvob command to remove the VOBs.

2 Use the ClearCase Administration Console or the cleartool lsview command to
locate all the views. Then use the ClearCase Administration Console or the
cleartool rmview command to remove the views.
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3 Use the ClearCase Administration Console or the cleartool lsstgloc command to
locate all the server storage locations. Then use the ClearCase Administration
Console or the cleartool rmstgloc command to remove the storage locations.

4 To remove registry values, use regedit to remove these lines:

HKLM\Software\Atria\ClearCase\CurrentVersion\ServerSetupComplete

HKLM\Software\Atria\ClearCase\CurrentVersion\CredmapAllowedDomainList

5 Delete the ClearCase LT /var directory from the installation directory.

Removing Rational RequisitePro

Removing RequisitePro does not remove RequisitePro project data from your system.

Removing RequisiteWeb

See the Installing Rational RequisitePro manual for removal instructions.

Removing Rational Testing Products

The following Rational testing software require special removal instructions.

Removing the Rational Unified Process

The Rational Software Setup program does not remove all the files from the Rational
Unified Process program folder. You can manually delete any files that the Setup
program does not remove.

To Remove See

UNIX Test Agent “Removing a UNIX Agent” in Installing
Rational Testing Products.

Rational Test Network Driver “Removing the Rational Test Network
Driver” in Installing Rational Testing Products.
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9Silent and Network
Installations
You can configure Rational Software Setup to perform silent and network installations
of Rational software. Silent installations let you repeatedly install a Rational Software
product, using the same parameters. A network installation lets you install the files
needed on client systems to run Rational products from a network location.

The Silent Installation White Paper provides examples of various types of silent
installations of Rational products, as well as sample files used in, or generated by,
silent installations. Read the whitepaper before you begin the installation. The
whitepaper is available at http://www.rational.com/. Select the following links in
order: Support, Documentation, Free Rational Documentation on the Web,
Whitepapers, and Rational Suite.

Performing Silent Installations

This section describes how to perform a silent installation.

Note: Before you set up a silent installation, make users either upgrade or remove
older Rational products from their systems. Users who perform silent installations do
not see error messages about upgrade compatibility. These messages will appear in
their error log files, but they may not remember to look at their log files after the
installation. For more information, see Ensuring Version Compatibility on page 27 and
Upgrading Rational Suite on page 85.

There are three basic tasks:

1 Record an installation session.

2 Optionally, add a post-installation command to the recorded session.

3 Run the installation session.

Recording a Software Installation

You can record a software installation session and then use the resulting response.ini
file to replay the session.
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1 Insert the Rational Solutions for Windows Disc 1 or 2 in a CD-ROM drive.

2 Open a command window on your system and run RSSetup with the
-autocapture switch. For example:

<location>\setup\rssetup -autocapture

Where <location> is the location of the Rational Solutions for Windows Disc.

3 When the Rational Software Setup program starts, proceed with the installation
procedure, as described in the chapter Installing Rational Suite on page 59. Your
responses will be recorded in the responses file <Install Path>\RSSetup\response.ini.

Note: When you use the -autocapture switch, you cannot use the temporary
license option. The silent installation procedure does not capture license certificate
information in the response.ini file.

4 After you have answered all of the questions, the Setup program prompts you to
continue with the installation of the product or to exit from the setup program.
Click OK to proceed with the installation or Cancel to exit.

Note: Even if you cancel at this point, your answers are still saved.

Specifying a Post-Installation Command

You can specify a task for the silent installation program to perform after the
installation has finished.

To specify a post-installation command, perform the following steps after you record
a response file:

1 Use a text editor such as Notepad to edit the response file. Append a line similar to
the following example to the end of the file. The label [PostInstallCmd] is
required:
[PostInstallCmd]

Command=post-installation-commands.bat

2 The post-installation-commands.bat is a batch file that contains the
commands to execute. Such a file might contain the following commands:
licadmin -fserver-info.txt

net send administrator “Installation Complete”

In this example, the License Key Administrator, licadmin, starts and uses the
information in server-info.txt to specify the name of the license server that the
current system will use. (See License Key Administrator Command Line on page 123
for the procedure.) The batch file then sends a message to the administrator,
indicating that the installation procedure is complete.
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3 Save the response file to a unique name (to ensure that it is not overwritten by
subsequent autocaptures). For example, save the response file with a name such as
c:\responses\enterprise-windows-post.ini

License Key Administrator Command Line

You can run the Rational License Key Administrator from a command line or batch
file to automate installing and configuring your license keys.

To specify the name of the Rational license server in a client’s License Key
Administrator:

1 Create a file that contains the following line:
Server:group-license-server

where group-license-server is the name of your Rational license server system.
The keyword Server is case-sensitive.

2 Save the file as filename.ext; for example, server-info.txt.

3 In a command window, run the following command:
licadmin -fserver-info.txt

Your system will be configured to use floating license keys from
group-license-server.

The results of running this command are written to the status file
filename.ext_STATUS, where filename.ext is the name of the license parameter file
you created. The status file is created in the directory where you executed the
licadmin command.

Replaying a Silent Software Installation

After you record your responses, use the response file to replay the installation, as in
the following example:

<location>\setup\rssetup -silent -response:response-path

In the example, response-path is the path of the response file. The default path is
c:\Program Files\Rational\RSSetup\response.ini.

If a response file is in the default location, you do not have to specify the
-response:response-path parameter. To override the default, include the
-response:response-path parameter on the command line.

Warning: Before distributing this file to users, find out where users have Rational
program files installed on their systems. If the location is different from the
location you specify in the response file, the silent installation will install the
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latest program files in the new location. Installations in two places affect
software performance. You may also have difficulty removing files with the
standard removal procedure described in Removing Rational Suite on
page 117. Rational Software does not support editing the response file
beyond adding a post-installation command and changing features
described in the Silent Installation White Paper.

Users must either upgrade or remove the older Rational products from their
systems before or after they perform a silent installation. In a silent
installation, users do not see error messages about upgrade compatibility.
These messages appear in users’ error log files, but they may not remember
to look at their log files after the installation.

For more information about ensuring version compatibility, see page 27.

If you specify -autocapture on the RSSetup command line, your installation will
initially select the product name identified in the previous response.ini file, but will
allow you to select a new product for installation. A new response.ini file will be
saved at the end of the installation procedure.

For additional information about the Rational Software Setup command-line syntax,
see RSSetup Command Syntax on page 126.

Preparing Multiple Response Files

You can save multiple response files to support an unattended installation of different
products.

1 Identify a directory where you will store your response files. The following
examples use a directory named C:\responses.

2 Record the response file for each product to install.

3 Rename the response file with a unique file name. For example, save the Rose
response file as C:\responses\Rose-response.ini.

4 Perform the installation and specify the path to the response file as a parameter to
the -response switch. For example:
<Install Location>\setup\rssetup -silent

-response:c:\response\Rose-response.ini

Note: Place this syntax on one line.
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Performing Network Installations

Using the command line, you can direct the Rational Software Setup program to copy
and decompress the product files to a network location. This network directory
provides a rssetup executable from which users on client systems can perform
network installations. The network option in the Setup program installs the files
(shared system DLLs and local configuration settings) needed on the client systems to
run Rational products (program files and executables) from the network directory.

Note: You can set up source directories on the network for both Rational installation
discs, but place them in unique target directories. If you do not give the target
directories for Disc 1 and 2 distinct names, the product files on one disc will overwrite
the product files from the other disc.

Configuring the Setup Program for Network Installations

This section provides the instructions for copying and decompressing the Rational
product files to a target directory on the network. All product files in a Rational
Solutions for Windows Disc are compressed into.cab files. Before the Rational
Software Setup program can offer a network installation option to clients, the Setup
program needs to expand the.cab files in this target directory.

The target location that you select must have at least 2.6 GB of space to accommodate
the expanded files. You must have write permission to set up the install location.

Note: If older Rational products are installed on server or client systems, do not
perform upgrades with the network installation type. For more information about
upgrades, see Ensuring Version Compatibility on page 27 and Upgrading from Earlier
Versions of Rational Suite on page 73.

To set up the network install location:

1 Insert the Rational Solutions for Windows Disc 1 or 2 in your CD-ROM drive.

2 Open a command window on your system and enter the RSSetup command:

<location>\setup\rssetup.exe -Admin:<dir>

Where<location> is the location of the Rational Solutions for Windows Disc and
<dir> is the target directory name. There is no space between -Admin: and the
target directory name.

3 The Rational Software Setup dialog box prompts you to start the procedure by
clicking Next.
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A window appears displaying Rational product files as they are copied to the
target location and then decompressed to subdirectories under the target location.

4 At the end of the procedure, the Installation Complete dialog box asks you to
complete the procedure by clicking Finish.

5 We recommend that you set this administrator directory and all its subdirectories
to read-only for users who will perform the network installation.

6 Give users the following information before they select the network installation
option:

a Users need 584 MB disk space on their systems to accommodate the shared
system DLLs and local configuration settings the Setup program will install on
their systems.

b Users should map a drive on their local systems to the source directory on the
network. In the Map Network Drive dialog box, users should select Reconnect at
Logon. If they do not select this option, the installation will not automatically
complete after the systems reboot.

They can then go to the network drive on their systems and select Network in
the Select Configuration dialog box of the Rational Software Setup program.

RSSetup Command Syntax

RSSetup [-silent [-response:response-path]]|
[-verbose [-response:response-path]] |
[-autocapture]
[/product <product>] [/install /uninstall /update]

Parameter Description

-silent Performs a silent (unattended) installation.

-verbose Replays a recorded installation, allowing you to
override the recorded responses.

Note: If you override the responses, those changes
are not written to the response file.

-response:response-path Specifies the path to the response file.
response-path is the path for the response file.

The default path is <Install Location>\Setup\
RSSetup\response.ini, where <Install Location> is
the location of the installation files.
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Table 14 lists the product identifiers to use with the /product switch.

-autocapture Records your responses to a software installation,
storing the responses in a file for later replay.

/product product-identifier Specifies the product you are installing.

Do not use this parameter for silent installations. For
a silent installation, specify the product name in the
response file instead.

See Table 14 on page 127 for the list of identifiers you
can use with this parameter.

/install Installs the product you specified with the
/product switch.

This switch cannot be combined with /uninstall
or /update.

Do not use this parameter for silent installations.

/uninstall Removes the product you specified with the
/product switch.

This switch cannot be combined with /install or
/update.

Do not use this parameter for silent installations.

/update Updates the product you specified with the
/product switch.

This switch cannot be combined with /install or
/uninstall.

Do not use this parameter for silent installations.

Table 14 Product Identifiers

Product Name Product Identifiers

Rational Test Agent atbuPSAgent

Rational Test Enablers atbuSetupEnablers

Rational TestManager atbuTestManager

Rational TeamTest atbuTeamTest

Rational Robot atbuTSRobot

Rational ClearCase LT Client ClearCaseLTClient

Parameter Description
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Rational ClearCase LT Server ClearCaseLTServer

Rational ClearQuest ClearQuest-1.1

Rational ClearQuest TeamTest Edition ClearQuestTeamTestEdition-1.1

Rational ContentStudio ContentStudio

Rational PureCoverage coverageNT

Rational Developer Kit dsbuDeveloperKit

Rational Suite DevelopmentStudio for
UNIX

dsbuRSDSU

Rational Purify purifyNT

Rational Quantify quantifyNT

Rational RequisitePro rmbuRequisitePro

Rational Rose Enterprise Edition Rose98i

Rational Rose Professional Ada Edition Rose98iAdaProfessional

Rational Rose Professional C++ Edition Rose98iC++Professional

Rational Rose Professional J Edition Rose98iJavaProfessional

Rational Rose Modeler Edition Rose98iModeler

Rational Rose Professional Visual Basic
Edition

Rose98iVBProfessional

Rational Rose Professional Data Modeler
Edition

RoseDataModelerProfessional

Rational Rose RealTime RoseRealTime

Rational Unified Process ruObjectory51

Rational SoDA for Word SoDA

Rational Suite AnalystStudio wsbuAnalystEdition

Rational Suite DevelopmentStudio wsbuDevelopmentStudio

Rational Suite DevelopmentStudio -
RealTime Edition

wsbuDevelopmentStudioRT

Rational Suite Enterprise wsbuEnterprise

Table 14 Product Identifiers (continued)

Product Name Product Identifiers
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Rational License Server wsbuFLEXlmServer

Sybase SQL Anywhere Database Server wsbuSQLAnywhereServer

Rational Suite TestStudio wsbuTestStudio

Rational Suite Team Unifying Platform wsbuUnifyingPlatform

Table 14 Product Identifiers (continued)

Product Name Product Identifiers
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10Troubleshooting
If you have any problems running the Rational Software Setup program or setting up
a silent installation, read Table 15 and the index of error messages in the Rational
Software Setup Help.

Installation Messages

Installation error messages, including messages for silent installations, are displayed
in the file <Install Path>\RSSetup\Error.log.

Table 15 describes some errors that you may encounter when you configure a silent
installation.

Table 15 Silent Installation Messages

Message Description

Product “ProductName” specified in
response file is not contained in the
product list.

This message appears when the response.ini
file contains an invalid product name.

Unable to open response file. Typically, this error occurs when the installation
procedure cannot locate the response.ini file.
Either you have specified an incorrect path or the
response.ini file is not in the default location.

Information required to remove the
specified product cannot be found.
The product may not be removed
automatically.

When you tried to remove a product with the
/uninstall switch, you either specified a product
that is not installed on your system or you
incorrectly typed the product name on the
command line.

Confirm that you are specifying a product on
your system. Confirm that you have typed the
product name exactly as it appears in the
Rational Software Setup program.
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Support Information

Contact Rational Support if you have questions about the installation, use, or
maintenance of Rational Software products.

Contacting Rational Technical Support on page xv provides Rational Technical Support
telephone and e-mail contact information.
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